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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Summary of Changes

This manual contains new and updated information as indicated in the 
following table.

Topic Page

Updated the illustrations to show two Ethernet ports on the Series B terminals with device 
level ring (DLR) network functionality. Series B terminals are also available with a single 
Ethernet port.

–

Added the EtherNet/IP Embedded Switch Technology Application Guide to the additional 
resources table.

9

Added new UL, INMETRO, and EAC certifications to the overview. 12

Added new dual Ethernet port information to the hardware features table. 12

Added INMETRO to secure digital (SD) card usage information in hazardous locations. 12

Added the DLR designator ‘22’ to the catalog number explanation table. 16

Added new catalog numbers to the product selections table. 16

Added the INMETRO standards and ratings next to the ATEX ratings. 19

Added new UL ratings to the hazardous locations tables. 21, 22

Added Portuguese language content for the hazardous locations table for INMETRO. 23

Added information for new dual Ethernet ports. 36

Added a description and network diagram for a DLR network topology. 37

Updated the settings dialog box with the new Ethernet link speed options. 56

Updated the settings dialog box with the new Ethernet ports configuration options. 56

Removed the processor temperature display field from the terminal information screen. 70

Added system information screen with Ethernet port configuration information. 111

PanelView™ Plus 7 Standard Terminal
Series A and Series B with One Ethernet Port

PanelView Plus 7 Standard Terminal
Series B with Dual Ethernet Ports
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Notes:
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Preface

This manual describes how to install, configure, operate, and troubleshoot the 
PanelView™ Plus 7 Standard terminals. It does not provide procedures on how 
to create applications that run on the terminals or ladder logic that runs in the 
controller.

Other tasks to perform include:
• Create a human machine interface (HMI) application for the terminal 

by using FactoryTalk® View Machine Edition (ME) software, version 7.0 
or later.

• Create ladder logic for the controller by using the Studio 5000 Logix 
Designer® application.

Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation.

You can view or download publications at
http://www.rockwellautomation.com/global/literature-library/overview.page. 
To order paper copies of technical documentation, contact your local 
Allen-Bradley distributor or Rockwell Automation sales representative.

Package Contents This product is shipped with the following items:
• PanelView Plus 7 Standard terminal with FactoryTalk View ME Station 

runtime software installed and activated
• Mounting levers for panel installation
• Removable power terminal block
• Secure Digital (SD) card cover
• Product information
• Cutout template
• China RoHS information
• Product Feature Notice

Resource Description

PanelView Plus 7 Standard Terminals Technical Data, 
publication 2711P-TD008 

Provides technical specifications, environmental specifications, and certifications for the PanelView Plus 7 Standard 
terminals.

Industrial Automation Wiring and Grounding Guidelines, 
publication 1770-4.1 

Provides general guidelines for installing a Rockwell Automation industrial system.

EtherNet/IP Embedded Switch Technology Application 
Guide, publication ENET-AP005 

Provides information on how to install, configure, and maintain linear and Device Level Ring (DLR) networks using 
Rockwell Automation® EtherNet/IP devices with embedded switch technology.

Safety Guidelines for the Application, Installation, and 
Maintenance of Solid-State Controls, publication SGI-1.1 

Provides general guidelines for the application, installation, and maintenance of solid-state control in the form of 
individual devices or packaged assemblies that use solid-state components.

Guidelines for Handling Lithium Batteries Technical Data, 
publication AG-5.4 

Provides guidelines to store, handle, install, and dispose of lithium batteries.

Product Certifications website,
http://www.rockwellautomation.com/global/certification/
overview.page 

Provides declarations of conformity, certificates, and other certification details.
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Product Release Notes Product release notes are available online within the Product Compatibility 
and Download Center.

1. From the Quick Links list on http://www.ab.com, choose Product 
Compatibility and Download Center.

2. From the Compatibility Scenarios tab or the Get Downloads tab, search 
for and choose your product.

3. Click the download icon  to access product release notes.
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Chapter 1

Overview

About the PanelView Plus 7 
Standard Terminals

The PanelView™ Plus 7 Standard terminals are operator interface devices. They 
monitor and control devices that are attached to ControlLogix® 5570 and 
CompactLogix™ 5370 controllers on an EtherNet/IP network. Animated 
graphic and text displays provide operators a view into the operating state of a 
machine or process. Operators interact with the control system by using touch 
screen input.

The PanelView Plus 7 Standard terminals include these features:
• Terminal functionality permits connection to 1 controller, up to 25 

screens, and up to 200 alarms.
• FactoryTalk® View Machine Edition software provides a familiar 

environment for creating HMI applications.
• Windows CE operating system with desktop access for configuration 

and third-party applications.
• Ethernet communication that supports Device Level Ring (DLR), 

linear, and star network topology.
• PDF viewer to access PDF files that are stored on the terminal.
• More screen options including 4-in., 6-in., 7-in., 9-in., 10-in., 12-in., and 

15-in. terminals.

Topic Page Topic Page

About the PanelView Plus 7 Standard Terminals 11 Start-up Options 15

Hardware Features 12 EtherNet/IP Communication 15

Operator Control 13 Typical Configuration 15

Software Support 13 Catalog Number Explanation 16

Windows CE Operating System 14 Product Selections 16

Open Versus Closed System 14 Accessories 17

Desktop Access 15 Ethernet Cables 18
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• Widescreen on three sizes, 4-in., 9-in., and 12-in. terminals.
• Greater screen resolution.
• Terminals are available with Allen-Bradley® branding, or with no 

branding for customers that want to put their own branding around the 
terminal.

• Certifications including Class I, Div. 2; Class II, Div. 2; Class III; ATEX 
and INMETRO Zones 2 and 22.

Hardware Features The PanelView Plus 7 Standard terminal features fixed-hardware 
configurations in a range of display sizes with touch screen input.

1
6
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Series A and Series B terminals 
with one Ethernet port.

Series B terminals with dual 
Ethernet ports.

Throughout this user manual, illustrations show the 
Series B terminals with dual Ethernet ports. 

Table 1 - Hardware Features

Item Feature Description

1 Display/Touch screen TFT color graphic display with a touch screen in a range of sizes: 
• 4.3-in. wide screen touch (WQVGA)
• 5.7-in. touch (VGA)
• 6.5-in. touch (VGA)
• 9.0-in. wide screen touch (WVGA)
• 10.4-in. touch (SVGA)
• 12.1-in. wide screen with touch (WXGA)
• 15.0-in. touch (XGA)

2 Power 24V DC nom (18…30V DC) nonisolated power input

3 Ethernet port 
(1 or 2)

• One 10/100Base-T, Auto MDI/MDI-X, Ethernet port for controller communication and IEEE 1588 support for synchronization of 
network-connected devices (Series A and Series B terminals).

• Two 10/100Base-T, Auto MDI/MDI-X, Ethernet ports for controller communication that supports Device Level Ring (DLR) network 
topology (Series B terminals).

4 Mounting slots Mounting levers insert into the slots to mount device in a panel or enclosure. The number of slots varies by terminal size.

5 Universal serial bus (USB) 
host port

One USB 2.0 high-speed (type A) host port.

6 USB device port One USB 2.0 high-speed (type B) device port for connecting a host computer.
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Operator Control All terminals have a color display with a touch screen for operator control. The 
resistive touch screen provides accurate, reliable, and durable touch control for 
industrial applications.

The touch screen supports touch gestures to interact with screen elements 
during runtime. Use only these touch gestures on the touch screen: 

• Tap – Briefly touch the target on the terminal screen with your 
fingertip.

• Double-tap – Touch the target on the terminal screen twice quickly 
with your fingertip.

• Drag – Touch the target on the terminal screen and move your fingertip 
across the screen. 

• Long press – Touch and hold the target on the terminal screen for 
several seconds. 

For a list of actions you can perform by using touch gestures, refer to the 
FactoryTalk View ME help.

Software Support

7 SD card slot and 
protective cover

• One SD card slot supports catalog number 1784-SDx hot-swappable SD cards for external storage.
• IMPORTANT: ATEX and INMETRO installations:

– Protective cover secures the SD card in the slot, and is required for ATEX, INMETRO, and hazardous location installations.
– See Insert an SD Card on page 121 for hot-swapping, ATEX, INMETRO, and hazardous location warnings.

8 Battery Battery cover provides access to the lithium battery for replacement.

9 Status indicators Status indicators on the back of the terminal provide status and fault conditions. 

Table 1 - Hardware Features

Item Feature Description

ATTENTION: The touch screen accepts input from a finger, stylus, or gloved 
hand for operation in dry or wet environments.
The plastic stylus must have a minimum tip radius of 1.3 mm (0.051 in.). 
Any other object or tool can damage the touch screen.
Do not conduct multiple operations simultaneously; it can result in unintended 
operation. Touch only one operating element on the touch screen with one 
finger, at one time. 

TIP At runtime, a virtual keyboard or numeric keypad opens on terminal 
screens for data entry.

IMPORTANT It is the responsibility of the customer to be sure that any third-party 
software, updates, patches, or firmware that is installed is free of malicious 
bugs, spyware, and so on. 
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PanelView Plus 7 Standard 
Applications

PanelView Plus 7 Standard Machine Edition applications are restricted to these 
applications:

• Maximum of 25 screens.
• Maximum of 200 alarm messages.
• One connection or shortcut to a controller by using either RSLinx® 

Enterprise or KEPServer Enterprise software.
• Only Ethernet communication is supported.

If RSLinx Enterprise software is used, then Ethernet drivers are 
supported.

Windows CE Operating 
System

The terminals run the Windows CE operating system. These devices run HMI 
applications and offer a desktop with these capabilities:

• File transfer protocol (FTP) server
• Virtual network computing (VNC) client and server
• ActiveX controls – Refer to View FactoryTalk View ME Station 

Information on page 72 to view a list of ActiveX controls installed on 
terminal.

• PDF reader
• Third-party device support

Open Versus Closed System You can configure a terminal to run an open or closed desktop environment:
• An open system launches the Windows desktop on startup. 
• A closed system launches a FactoryTalk View ME application or 

FactoryTalk View ME Station on startup. Desktop access is restricted. 

All terminals are shipped as closed systems. 

Table 2 - PanelView Plus 7 Standard Software Support

Software Description Version

FactoryTalk View ME Station Runtime environment of terminal:
• Runs FactoryTalk View ME applications.
• Provides options to view and configure terminal settings.
Machine Edition Station is preloaded on each terminal and does not require activation.

7.0 or later

FactoryTalk View Studio for Machine Edition Software for developing the HMI applications that run on terminal. This software does not run on the 
terminal. The HMI applications that are created in this software are loaded onto the terminal. 

7.0 or later

FactoryTalk ViewPoint A web server application that lets remote users access and control the HMI application that runs on a 
terminal by using an internet browser.
A license is embedded with each terminal that supports a client connection to a terminal.

1.2 or later

TIP For a complete list of ActiveX controls, go to http://
www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘ActiveX Support for PanelView Plus 
Terminals’. 
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Desktop Access You can allow or restrict access to the Windows desktop on the terminal. From 
the desktop, you can perform system and control panel operations or run third-
party applications. You can even allow access temporarily to perform specific 
tasks, then disable desktop access to prevent unauthorized changes.

Refer to Desktop Access on page 46 for details on how to modify desktop 
access.

Start-up Options The terminal can perform one of three actions at startup:
• Launch a FactoryTalk View ME HMI application.
• Launch FactoryTalk View ME Station in Configuration mode. This 

mode lets you configure terminal settings and start-up options, load 
applications to run, and enable or disable desktop access. 

• Launch the Windows desktop.

The factory default state and start-up option after a firmware update is to 
launch the terminal in Configuration mode. Refer to Configure Start-up 
Options on page 51 for details on how to change the start-up option.

EtherNet/IP Communication PanelView Plus 7 Standard terminals communicate with ControlLogix 5570 
and CompactLogix 5370 controllers over an EtherNet/IP connection.

Typical Configuration Traditional DLR, linear, and star network topologies are supported. See these 
topics for examples:

• Device Level Ring Network Topology on page 37
• Linear Network Topology on page 38
• Star Network Topology on page 39

TIP All terminals are shipped with desktop access disabled. 
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Catalog Number Explanation See the table for an explanation of the terminal catalog number.

Product Selections Table 3 provides a description of the product selections.

Bulletin Input Type Display Size Display Type Network Power Operating 
System

Model - Option

| | | | | | | |

2711P- T = Touch 4 = 4.3-in. C = Color 21 = Single Ethernet port D = DC  8 = Windows CE S = Standard(1) - B = No brand 
label

6 = 5.7-in. W = Wide aspect-ratio color 22 = Embedded switch/DLR

7 = 6.5-in.

9 = 9.0-in.

10 = 10.4-in.

12 = 12.1-in.

15 = 15.0-in.

(1) The standard models support the Windows CE version 6.0 operating system with an FTP server, VNC client server, ActiveX controls, and PDF reader.

Table 3 - PanelView Plus 7 Standard Terminals Product Selections

Cat. No.(1) Display  Input 
Power 

Ethernet Ports Memory

Touch Screen  Size Type Aspect 
Ratio

Pixels
(W x H)

Single DLR RAM Nonvolatile

2711P-T4W21D8S 4.3-in. WQVGA 
TFT color

16:9 480 x 272 DC • 512 MB 512 MB nonvolatile 
memory

(Approx. 80 MB free 
user memory)

2711P-T4W22D8S •

2711P-T6C21D8S 5.7-in. VGA 
TFT color

4:3 640 x 480 •

2711P-T6C22D8S •

2711P-T7C21D8S 6.5-in. VGA 
TFT color

4:3 640 x 480 •

2711P-T7C22D8S •

2711P-T9W21D8S 9.0-in. WVGA 
TFT color

5:3 800 x 480 •

2711P-T9W22D8S •

2711P-T10C21D8S 10.4-in. SVGA 
TFT color

4:3 800 x 600 •

2711P-T10C22D8S •

2711P-T12W21D8S 12.1-in. WXGA
TFT color

16:10 1280 x 800 •

2711P-T12W22D8S •

2711P-T15C21D8S 15.0-in. XGA
TFT color

 4:3 1024 x 768 •

2711P-T15C22D8S •

(1) Add -B to the end of a catalog number to order a terminal without the Allen-Bradley logo and product identification; for example, 2711P-T9W21D8S-B.



Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015 17

Overview Chapter 1

Accessories Table 4 through Table 9 list accessories for the PanelView Plus 7 Standard 
terminals.

Table 4 - Protective Overlays

Cat. No. Display Size Touch Input Quantity

2711P-RGT4S 4.3-in. • 3

2711P-RGT6S 5.7-in. • 3

2711P-RGT7SP 6.5-in. • 3

2711P-RGT9SP 9.0-in. • 3

2711P-RGT10SP 10.4-in. • 3

2711P-RGT12SP 12.1-in. • 3

2711P-RGT15SP 15-in. • 3

Table 5 - Power Supplies and Power Terminal Blocks

Cat. No. Description Quantity

1606-XLP95E DIN-rail power supply, 24…28V DC output voltage, 95 W 1

1606-XLP100E DIN-rail power supply, 24…28V DC output voltage, 100 W 1

2711P-RSACDIN DIN-rail power supply, AC-to-DC, 85…265V AC, 47…63 Hz 1

2711P-RTBDSP 3-pin DC power terminal block (black with white labels for +, –, and GND) 10

Table 6 - Mounting Hardware

Cat. No. Description Quantity

2711P-RMCS(1)

(1) Catalog number 2711P-RMCS mounting levers are for use only with PanelView Plus 7 Standard terminals. Do not use these 
mounting levers with any other PanelView Plus terminals. Do not use black mounting levers; they are not compatible with 
PanelView Plus 7 Standard terminals.

Mounting levers (gray) 12

Table 7 - SD Cards (1)

(1) To reduce the chance of corruption when using SD Cards or USB drives with the terminal, Rockwell Automation recommends 
that you use SD Card catalog numbers 1784-SD1 or 1784-SD2. 

Cat. No. Description Quantity

1784-SD1 1-GB SD card 1

1784-SD2 2-GB SD card 1

2711C-RCSD USB to SD adapter for SD card 1

2711P-RCKS SD cover replacement 3

Table 8 - USB Programming Cable

Cat. No. Description Length

6189V-USBCBL2 Programming cable that connects the device port of the terminal to a 
USB host port of a computer

1.8 m (5.9 ft)
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Ethernet Cables See the Industrial Ethernet Media Brochure, publication 1585-BR001B, for 
recommended Ethernet cables and media solutions.

See the USB to Serial Adapter Quick Start Guide, publication 
GMSC10-QS003, for information on USB to serial port adapters.

Table 9 - Battery Replacement

Cat. No. Description Quantity

2711P-RY2032 Lithium coin-cell battery, CR2032 equivalent 1

2711P-RYKS Battery cover replacement 3
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Install the PanelView Plus 7 Standard Terminal

The equipment meets the requirements of the standards and ratings that are 
listed in Table 10.

Table 10 - ATEX and INMETRO Ratings

Topic Page

Hazardous Locations 21

Considerations for Mounting 25

Clearances for Mounting 25

Panel Guidelines 26

Panel Cutout Dimensions 26

Prepare for Panel Mounting 27

Mount the Terminal in a Panel 30

Remove and Replace Power Terminal Block 34

Connect Power 35

Connect to a Network 36

Initial Startup 40

Reset the Terminal 40

ATTENTION: Do not use a PanelView™ Plus 7 Standard terminal for 
emergency stops or other controls critical to the safety of personnel or 
equipment. Use separate hard-wired operator interface devices that do not 
depend on solid-state electronics.

ATEX:
EN 60079-0:2009, EN 60079-11:2012, EN 60079-15:2010, 
and EN 60079-31:2009 
II 3 GD
Ex ic nA IIC T4 Gc
Ex tc IIIC T135 °C (275 °F) Dc IP66
Tamb = 0 °C…+55 °C (32 °F…+131 °F)
DEMKO 14 ATEX 1302X

INMETRO:
ABNT NBR IEC 60079-0:2008+Errata 1:2011; ABNT 
NBR IEC 60079-11:2009; ABNT NBR IEC 60079-
15:2012; e ABNT NBR IEC 60079-31:2011
Ex ic nA IIC T4 Gc
Ex tc IIIC T135 °C (275 °F) Dc IP66
Tamb = 0 °C to +55 °C (32 °F to +131 °F)
UL-BR 14.0716X
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ATTENTION: Environment and Enclosure
This equipment is intended for use in a Pollution Degree 2 industrial environment, in overvoltage Category II applications (as 
defined in IEC 60664-1), at altitudes up to 2000 m (6561 ft) without derating.
The terminals are intended for use with programmable logic controllers.
This equipment is considered Group 1, Class A industrial equipment according to IEC CISPR 11. Without appropriate precautions, 
there may be difficulties with electromagnetic compatibility in residential and other environments due to conducted or radiated 
disturbances.
Korean Radio Wave Suitability Registration - When so marked this equipment is registered for Electromagnetic 
Conformity Registration as business equipment (A), not home equipment. Sellers or users are required to take 
caution in this regard.
이 기기는 업무용 (A 급 ) 전자파적합기기로서 판 매자 또는 사용자는 이 점을 주의하시기 바라 
며 , 가정외의 지역에서 사용하는 것을 목적으 로 합니다 .

This equipment is supplied as open-type equipment. It must be mounted within an enclosure that is suitably designed for those 
specific environmental conditions that will be present and appropriately designed to prevent personal injury resulting from 
accessibility to live parts. The interior of the enclosure must be accessible only by the use of a tool. The terminals meet specified 
NEMA, UL Type, and IEC ratings only when mounted in a panel or enclosure with the equivalent rating. Subsequent sections of 
this publication may contain additional information regarding specific enclosure type ratings that are required to comply with 
certain product safety certifications.
In addition to this publication, see the following:
• Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1, for additional installation requirements
• NEMA 250 and IEC 60529, as applicable, for explanations of the degrees of protection provided by different types of 

enclosure

ATTENTION: Wiring and Safety Guidelines
Use publication NFPA 70E, Electrical Safety Requirements for Employee Workplaces, IEC 60364 Electrical Installations in 
Buildings, or other applicable wiring safety requirements for the country of installation when wiring the devices. In addition to 
the NFPA guidelines, here are some other guidelines to follow:
• Employ only qualified electricians to wire the device in accordance with local, state, and national codes. 
• Connect the device and other similar electronic equipment to its own branch circuit.
• Protect the input power by a fuse or circuit breaker rated at no more than 15 A.
• Route incoming power to the device by a separate path from the communication lines.
• Cross power and communication lines at right angles if they must cross. 
• Communication lines can be installed in the same conduit as low-level DC I/O lines (less than 10V).
• Shield and ground cables appropriately to avoid electromagnetic interference (EMI). Grounding minimizes noise from EMI 

and is a safety measure in electrical installations. 
For more information on grounding recommendations, refer to the National Electrical Code published by the National Fire 
Protection Association.
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Hazardous Locations The following information applies when operating this equipment in 
hazardous locations.

When marked, these products are suitable for use in Class I, Division 2, 
Groups A, B, C and D; Class II, Division 2, Groups F and G; Class III 
hazardous locations and nonhazardous locations only. Each product is supplied 
with markings on the rating nameplate indicating the hazardous location 
temperature code. When combining products within a system, the most 
adverse temperature code (lowest “T” number) can be used to help determine 
the overall temperature code of the system. Combinations of equipment in 
your system are subject to investigation by the local authority having 
jurisdiction at the time of installation.
  

WARNING: EXPLOSION HAZARD
The following information applies when operating this equipment in hazardous locations.
This equipment is suitable for use in Class I, Division 2, Groups A, B, C and D; Class II, Division 2, Groups F and G; Class III 
hazardous locations and nonhazardous locations only.
• Do not disconnect equipment unless power has been removed or the area is known to be nonhazardous.
• Do not disconnect connections to this equipment unless power has been removed or the area is known to be nonhazardous. 

Secure any external connections that mate to this equipment by using screws sliding latches, threaded connectors, or other 
means provided with this product.

• When installed in a hazardous location do not open the enclosure, install or remove the memory card or battery, or connect 
or disconnect equipment unless the area is known to be nonhazardous.

• Substitution of components can impair suitability for Class I, Division 2.
• Peripheral equipment must be suitable for the location where it is used.
• All wiring must be in accordance with Class I, Division 2, Class II, Division 2, or Class III wiring methods of Articles 501, 502 or 

503, as appropriate, of the National Electrical Code and/or in accordance with Section 18-1J2 of the Canadian Electrical 
Code, and in accordance with the authority having jurisdiction.

• When used in Class II and Class III hazardous locations these products must be installed in a dust-tight enclosure in 
accordance with Articles 502 and 503 of the National Electrical Code.

• For ATEX and INMETRO Zone 2 applications, transient limiting shall be provided in the application that limits transient 
overvoltages to not more than 40% above the applied voltage.

• For ATEX and INMETRO applications, mount the display in environments where ultraviolet (UV) light cannot influence the 
nonmetallic parts.

• USB device port is for maintenance use only, it is not to be used during normal operation of the device.
• Install the display in the cutout of an enclosure by using the provided clamps to compress the bezel gasket to form a seal 

against the panel. The gasket seal is permanent for the installation.
• Use field/power wiring that is rated to a minimum of 90 °C (194 °F).
• Install the display in a location that minimizes the risk of impact from other objects. Do not drop, jolt, or impact the display 

during installation.
• For ATEX and INMETRO, mount the display through an enclosure wall with a minimum ingress protection rating of IP54 

(Zone 2 applications) and IP6x (Zone 22 applications), and in an overall environment not exceeding Pollution Degree 2. (The 
display supports enclosure ratings up to IP66.) For ATEX, the enclosure must meet the requirements of EN 60079-0:2009; EN 
60079-11:2012; EN 60079-15:2010; and EN 60079-31:2009 as applicable. For INMETRO, the enclosure must meet the 
requirements of ABNT NBR IEC 60079-0:2008+Errata 1:2011; ABNT NBR IEC 60079-11:2009; ABNT NBR IEC 60079-15:2012; 
and ABNT NBR IEC 60079-31:2011 as applicable.

• Do not use the USB ports in ATEX and INMETRO Zone 2 and Zone 22 applications unless the area is known to be 
nonhazardous.
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Informations sur l'utilisation de cet équipement en environnements dangereux:

Les produits marqués "CL I, DIV 2, GP A, B, C, D" ne conviennent qu'à une 
utilisation en environnements de Classe I, Division 2, Groupes A, B, C et D ; 
Classe II, Division 2, Groupes F et G ; Classe III dangereux et non dangereux. 
Chaque produit est livré avec des marquages sur sa plaque d'identification qui 
indiquent le code de température pour les environnements dangereux. Lorsque 
plusieurs produits sont combinés dans un système, le code de température le 
plus défavorable (code de température le plus faible) peut être utilisé pour 
déterminer le code de température global du système. Les combinaisons 
d'équipements dans le système sont sujettes à inspection par les autorités locales 
qualifiées au moment de l'installation.

AVERTISSEMENT :  RISQUE D’ EXPLOSION
Les informations suivantes s'appliquent lorsque cet équipement fonctionne dans des zones dangereuses.
Cet équipement est utilisable uniquement en Classe I, Division 2, Groupes A, B, C et D ; Classe II, Division 2, Groupes F et G ; Classe 
III dangereux et non dangereux.
• Couper le courant ou s'assurer que la zone est classée non dangereuse avant de débrancher l'équipement.
• Couper le courant ou s'assurer que la zone est classée non dangereuse avant de débrancher les connexions de l'équipement. 

Fixer tous les connecteurs externes reliés à cet équipement à l'aide de vis, loquets coulissants, connecteurs filetés ou autres 
moyens fournis avec ce produit.

• En cas d'installation dans un environnement dangereux ne pas ouvrir l'enceinte, installer ou retirer la carte mémoire ou la 
pile, connecter ou déconnecter d'équipement sauf si la zone est reconnue comme étant non dangereuse. 

• La substitution de composants peut rendre cet équipement impropre à une utilisation en Classe I, Division 2.
• Les équipements périphériques doivent convenir à l'environnement dans lequel ils sont utilisés.
• Tous les systèmes de câblage doivent être de Classe I, Division 2, Classe II, Division 2, ou Classe III conformément aux 

méthodes de câblage indiquées dans les Articles 501, 502 ou 503 du Code Electrique National (National Electrical Code) et/ou 
conformément à la Section 18-1J2 du Canadian Electrical Code (Code Electrique Canadien), et en fonction de l'autorité de 
jurisdiction.

• Quand ces produits sont utilisés dans des environnements dangereux de Classe II et Classe III, ils doivent être installés dans 
une enceinte étanche aux poussières conformément aux Articles 502 et 503 du Code Electrique National (National Electrical 
Code).

• Pour les applications en Zone 2 ATEX et INMETRO, une protection contre les transitoires sera fournie pour limiter les 
surtensions transitoires à 40 % au-dessus de la tension assignée.

• Pour les applications ATEX et INMETRO, installer l'afficheur dans des environnements où le rayonnement ultraviolet (UV) ne 
peut pas détériorer les parties non métalliques.

• Le port pour dispositif USB est destiné à la maintenance uniquement, il ne doit pas être utilisé pendant le fonctionnement 
normal du dispositif.

• Installer l'afficheur dans la découpe d'une enceinte en utilisant les fixations fournies pour comprimer le joint de 
l'encadrement et assurer l'étanchéité avec la paroi. L'étanchéité du joint doit être permanente pour l'installation.

• Utiliser un câblage de terrain/d'alimentation normalisé pour une température minimum de 90 °C (194 °F).
• Installer l'afficheur dans un emplacement qui minimise le risque de choc par d'autres objets. Pendant l'installation l'afficheur 

ne doit pas tomber, subir des secousses ou des chocs.
• Pour les applications ATEX et INMETRO, encastrer l'afficheur dans la paroi d'une enceinte ayant un indice de protection 

minimum IP54 (applications en zone 2) et IP6x (applications en zone 22) et un environnement général ne dépassant un 
degré de pollution 2. (L'afficheur supporte des classifications d'enceinte jusqu'à IP66). Pour les applications ATEX, l'enceinte 
doit répondre aux exigences des nornes EN 60079-0:2009; EN 60079-11:2012; EN 60079-15:2010; et EN 60079-31:2009 le 
cas échéant. Pour les applications INMETRO, l'enceinte doit répondre aux exigences des nornes ABNT NBR IEC 60079-
0:2008+Errata 1:2011; ABNT NBR IEC 60079-11:2009; ABNT NBR IEC 60079-15:2012; and ABNT NBR IEC 60079-31:2011 le 
cas échéant.

• Ne pas utiliser les ports USB dans les applications ATEX et INMETRO en zones 2 et 22, sauf si la zone est reconnue comme étant 
non dangereuse.
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As informações a seguir aplicam-se ao operar este equipamento em áreas 
classificadas.

Os produtos marcados com “CL I, DIV 2, GP A, B, C, D” são adequados 
somente para utilização em áreas classificadas de Classe I, Divisão 2, Grupos A, 
B, C e D e em áreas não classificadas. Cada produto é fornecido com marcações 
na placa de identificação de classificação que indicam o código de temperatura 
da área classificada. Ao combinar produtos em um sistema, o código de 
temperatura mais adverso (número “T” mais baixo) pode ser usado para ajudar 
a determinar o código de temperatura geral do sistema. As combinações de 
equipamentos em seu sistema estão sujeitas à fiscalização das autoridades locais 
com jurisdição no momento da instalação.

The terminals have a temperature code of T4 when operating in a 55 °C (131 
°F) maximum ambient temperature. Do not install product in environments 
where atmospheric gases have ignition temperatures less than 135 °C (275 °F). 

ATENÇÃO: Risco de explosão
As informações a seguir aplicam-se ao operar este equipamento em áreas classificadas.
Este equipamento é adequado para utilização somente em áreas classificadas de Classe I, Divisão 2, Grupos A, B, C e D ou em 
áreas não classificadas.
• Não desconecte o equipamento, a não ser que a alimentação tenha sido removida ou a área seja conhecida como não 

classificada.
• Não desligue as conexões deste equipamento, a não ser que a alimentação tenha sido removida ou a área seja conhecida 

como não classificada. Proteja quaisquer conexões externas a este equipamento utilizando as travas deslizantes, os 
conectores com rosca ou outros meios fornecidos com este produto.

• Quando instalado em uma atmosfera explosiva, não abra o gabinete, instale ou remova o cartão de memória ou bateria, 
conecte ou desconecte o equipamento a menos que a área seja conhecida como não-classificada.

• A substituição dos componentes pode prejudicar a adequação para a Classe I, Divisão 2.
• Os equipamentos periféricos devem ser adequados para o local onde são utilizados.
• Toda a fiação deve estar em conformidade com os métodos de fiação de Classe I, Divisão 2 do artigo 501 do Código Elétrico 

Nacional e/ou em conformidade com a Seção 18-1J2 do Código Elétrico Canadense e em conformidade com a autoridade que 
tiver jurisdição.

• Para aplicações em zona 2 ATEX e INMETRO, deverá ser fornecida limitação transiente na aplicação que limitar as 
sobretensões transientes a não mais do que 40% acima da tensão aplicada.

• Para aplicações ATEX e INMETRO, instale a tela em ambientes onde a luz ultravioleta (UV) não possa influenciar as partes não 
metálicas.

• A porta para dispositivo USB destina-se apenas para manutenção e não deve ser utilizada durante a operação normal do 
dispositivo.

• Instale a tela no recorte de um gabinete utilizando os grampos fornecidos para comprimir a junta da moldura e formar uma 
vedação contra o painel. A junta de vedação é permanente para a instalação. 

• Utilize fiação de campo/alimentação que seja classificada para um mínimo de 90 °C (194 °F).
• Instale a tela em um local que minimize o risco de impacto de outros objetos. Não derrube, bata ou cause impacto na tela 

durante a instalação.
• Para ATEX e INMETRO, instale a tela através de uma parede de gabinete com classificação mínima de proteção de entrada de 

IP54 (aplicações de zona 2) e IP6x (aplicações de zona 22) e em um ambiente geral que não ultrapasse o grau de poluição 2 
(a tela suporta grau de proteção do gabinete até IP66). Para ATEX, o gabinete deve atender os requisitos da EN 60079-
0:2009; EN 60079-11:2012; EN 60079-15:2010; e EN 60079-31:2009, conforme aplicável. Para INMETRO, o gabinete deve 
atender os requisitos da ABNT NBR IEC 60079-0:2008+Errata 1:2011; ABNT NBR IEC 60079-11:2009; ABNT NBR IEC 60079-
15:2012; e ABNT NBR IEC 60079-31:2011, conforme aplicável. 

• Não utilize as portas USB em aplicações ATEX e INMETRO de zona 2 e 22, a menos que a área seja conhecida como não 
classificada.
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Required Circuit Port Parameters for USB Peripheral Devices

This product contains a USB host port that complies with hazardous location 
environments. Field wiring compliance requirements are provided in 
compliance with the National Electrical Code, Article 500.

Figure 1 - PanelView Plus 7 Standard Terminal Control Drawing

PanelView Plus 7 Standard terminals provide one powered USB host port. Table 11 defines the circuit parameters port.

Application Information

Per the National Electrical Code (NEC), the circuit parameters of associated 
field-wiring apparatus for use in hazardous locations is coordinated with the 
host product so that their combination remains nonincendive. PanelView Plus 
7 Standard terminals and the USB peripheral devices are treated in this 
manner.

Make sure that the USB peripheral device and its associated cabling have 
circuit parameters with the limits given in Table 11. These parameters are 
required for the device and cabling to remain nonincendive when used with 
the PanelView Plus 7 Standard terminal USB host port.

Nonincendive Field 
Wiring Apparatus

Associated Nonincendive Field Wiring Apparatus

PanelView Plus 7 Standard Host Product

USB Peripheral DeviceUSB Host Port

Table 11 - Circuit Parameters for USB Host Port

Parameter Value Parameter Definition

V oc (USB) 5.25V DC Open circuit voltage of the host USB port.
The maximum applied voltage rating, Vmax (peripheral), of the USB peripheral device is
greater than or equal to Voc (USB).

Vmax (peripheral) ≥ Voc (USB) 
(as appropriate)

I sc (USB) 1.68 A Maximum output current of the host USB port.
The maximum current, Imax (peripheral), that the USB peripheral device can be subjected to is
greater than or equal to I sc (USB).

Imax (peripheral) ≥ I sc (USB)

C a (USB) 10 μF This value is the maximum total capacitance that can be connected to the USB host port. The total capacitance 
of the USB peripheral device and its associated cable must not exceed the indicated value. 
The maximum total capacitance, Ci (peripheral), and cable capacitance of the separate USB peripheral device is
less than or equal to Ca (USB).

Ci (peripheral) + Ccable(USB) ≤ Ca (USB)

L a (USB) 15 μH This value is the maximum total inductance that can be connected to the USB host port. The total inductance of 
the USB peripheral device and its associated cable must not exceed the indicated value. 
The maximum total inductance, Li (peripheral), and cable inductance of the separate USB peripheral device is
less than or equal to La (USB).

Li (peripheral) + Lcable ≤ La (USB)
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If cable capacitance and inductance are not known, use the following values 
from ANSI/ISA-RP 12.06.01-2003:

Ccable = 197 pF/m (60 pF/ft)
Lcable = 0.7 µH/m (0.20 µH/ft)

Nonincendive field wiring must be wired and separated in accordance with 
501.10(B)(3) of the National Electrical Code, ANSI/NFPA 70, or other local 
codes as applicable. This associated nonincendive field wiring apparatus has 
not been evaluated for use in combination with another associated 
nonincendive field wiring apparatus.

Considerations for Mounting Consider the following items when mounting the terminal: 
• Typically, the terminal mounts on the vertical surface of a panel or 

enclosure, at a 0° angle, just below eye level.
• Mount the terminal at a height suitable for most operators.
• Mount the terminal in an area that has good lighting.
• Do not mount the terminal where it is exposed to direct sunlight.

Clearances for Mounting Plan for adequate space around the terminal and inside the enclosure for 
ventilation and cables. Consider the heat produced by other devices in the 
enclosure. The ambient temperature around the terminal must be 0…55 °C 
(32…131 °F).

Table 12 - Minimum Required Clearances

Product Area Min Clearance

Top 51 mm (2 in.)

Bottom 51 mm (2 in.)

Side 25 mm (1 in.) on side without an SD card

51 mm (2 in.) on side with SD card

Back 0 mm (0 in.) 
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Panel Guidelines Mount the terminals in the door or wall of a NEMA, UL Type, or IP rated 
enclosure:

• The enclosure must be of type IP20 or greater protection.
• Panels must have a minimum thickness of 1.5…4.8 mm (0.060…0.188 

in.).
• The material strength and stiffness of the panel must be sufficient to 

hold the terminal and maintain an appropriate seal against water and 
dust.

• The panel surface must be flat and free of imperfections to maintain an 
adequate seal, and NEMA, UL Type, and IP ratings. 

Panel Cutout Dimensions Use the template that is shipped with your terminal to mark the cutout 
dimensions.

Table 13 - Panel Cutout Dimensions - PanelView Plus 7 Standard Terminals

Terminal Size Input Type Height, mm (in.) Width, mm (in.)

4.3-in. Touch 92 (3.62) 117 (4.61)

5.7-in. Touch 123 (4.84) 156 (6.14)

6.5-in. Touch 142 (5.59) 184 (7.24)

9.0-in. Touch 162 (6.38) 252 (9.92)

10.4-in. Touch 224 (8.82) 269 (10.59)

12.1-in. Touch 218 (8.58) 312 (12.28)

15.0-in. Touch 290 (11.42) 353 (13.90)
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Prepare for Panel Mounting Before mounting a terminal in a panel, read this section and the entire 
installation procedure on page 30.

Mounting levers insert into the slots around the bezel to secure the terminal in 
the panel. The number of mounting levers varies by terminal size. 

Each slot has six notches with alignment marks that are locking positions for a 
mounting lever. The thickness of the panel that you mount the terminal in 
determines the locking position that is required to maintain a NEMA, UL 
Type, and IP seal.

Always orient a mounting lever vertically before inserting it into a slot. This 
method is the only way to slide the mounting lever knob within the slot for 
positioning. After sliding the mounting lever to a specific notch, rotate the 
mounting lever toward the panel to lock it in position. The flat side of the 
mounting lever must come into contact with the panel.

IMPORTANT Use catalog number 2711P-RMCS mounting levers (gray) for PanelView 
Plus 7 Standard terminals. Do not use these mounting levers with any other 
PanelView Plus terminals. Do not use black mounting levers; they are not 
compatible with PanelView Plus 7 Standard terminals.

Table 14 - Mounting Lever Locking Positions

Mounting Slot
Mounting 
Lever Lock 

Position
Panel Thickness Range Typical 

Gauge

1 1.50…2.01 mm (0.060…0.079 in.) 16

2 2.03…2.64 mm (0.08…0.104 in.) 14

3 2.67…3.15 mm (0.105…0.124 in.) 12

4 3.17…3.66 mm (0.125…0.144 in.) 10

5 3.68…4.16 mm (0.145…0.164 in.) 8/9

6 4.19…4.80 mm (0.165…0.188 in.) 7

1 6

1 2 3 4 5 6

Alignment Marks

Notch
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Initially, you secure the terminal in the panel by sliding each mounting lever to 
a position that is one or two notches greater than the final lock position. For 
example, if the final lock position is 1, slide each mounting lever to position 2 
or 3. Follow the sequence specific to the terminal size shown in Figure 3 on 
page 29.

Figure 2 on page 28 shows the mounting lever orientation and locking 
sequence for a 5.7-in. and 10.4-in. terminal. See Figure 3 on page 29 for locking 
sequence and mounting lever orientations for all terminals.

Figure 2 - Mounting Levers Shown in Locked Position

61 6 1 Flat Side

Knob on reverse side of 
mounting lever inserts 
into large end of slot.

1 2 3 4

Inner notch on mounting lever 
shows current lever position.

You can use an erasable marker or grease pencil to mark the alignment 
marks below the slot for visibility of slot positions.

TIP If the lock position is 6, slide the mounting lever to the large end of the slot 
or insertion hole.

1 661

32

The notch shows the locked position. 3 10 1

2 9 4

8

6

7

5
13

42

5
6

All mounting levers are locked in position 1.This is appropriate for a 
panel thickness of 1.50…2.01 mm (0.060…0.079 in.).



Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015 29

Install the PanelView Plus 7 Standard Terminal Chapter 2

Figure 3 - Mounting Lever Orientation and Lock Sequence

1 6 1 6 2 4

6 5

9.0-in. Touch - 8 Levers

3 1

4.3-in. Touch - 4 Levers 5.7-in. Touch - 6 Levers

5

2 4

8

6.5-in. Touch - 6 Levers

7
6

3

1

2

3

4

3 1

2 4

6 5

1

103

2 9 4

7

5

6

8

10.4-in. and 12.1-in. Touch - 10 Levers

The box indicates that the levers must be rotated in the 
orientation that is shown to avoid interference with 
ports and cables.

1

IMPORTANT: The mounting lever orientations that are shown are required to maintain 
NEMA, UL Type, and IP seals. If you require a NEMA, UL Type, or IP seal, do not use a 
mounting lever in another orientation than shown.

15-in. Touch - 12 Levers

11

9

10

12

73 5 1

2 6 8 4
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Mount the Terminal in a 
Panel

The terminals were designed for single-person installation. No tools are 
required to mount the terminal. Some tools are required to make the panel 
cutout.

Follows these steps to mount the terminal in a panel.

1. Use the cutout dimensions on page 26 to cut an opening in the panel. 

2. Verify that the sealing gasket is present on the terminal.

This gasket forms a compression-type seal. Do not use sealing 
compounds.

3. Center the terminal in the panel cutout.

4. See Table 14 on page 27 to get the final lock position of the mounting 
levers for the panel thickness.

5. See Figure 3 on page 29 to determine the mounting lever orientations 
and lock sequence for your terminal size.

ATTENTION: 
Disconnect all electrical power from the panel before making the panel cutout.
Make sure that the area around the panel cutout is clear and that the panel is 
clean of any debris, oil, or other chemicals.
Make sure that metal cuttings do not enter any components that are already 
installed in the panel and that the edges of the cutout have no burrs or sharp 
edges.
Failure to follow these warnings can result in personal injury or damage to 
panel components.

Gasket
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6. Secure the terminal in the panel.

a. Verify the orientation of the mounting lever.

The direction that you rotate each mounting lever is different for 
each terminal size. 

b. Hold the first mounting lever in the locking sequence vertical to the 
slot and insert its knob into the large end of the slot. 

c. Slide the mounting lever to a notch that is one or two positions 
greater than the final locking position for your panel thickness.

If the final locking position is 1, slide the mounting lever to position 2 
or 3.

TIP The mounting levers for PanelView Plus 7 Standard terminals are gray, 
similar to the color of the bezel (catalog number 2711P-RMCS).
Do not use black mounting levers; they are not compatible with PanelView 
Plus 7 Standard terminals.

TIP To mark the alignment marks for visibility of the slot positions and 
to mark the final lock position, use an erasable marker or grease 
pencil. 

1 6 1 6

1 6

1 6

32
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d. Rotate the mounting lever until its flat side comes in contact with the 
panel.

e. Repeat steps a through d for the remaining mounting levers.

7. Adjust each mounting lever to its final position by using the same 
locking sequence in Figure 3 on page 29.

a. Unlock mounting lever one in the sequence by rotating it away from 
the bezel.

b. With the mounting lever positioned vertically to the slot, slide the 
mounting lever to the final locking position in Table 14 on page 27.

c. Carefully rotate the mounting lever back toward panel.

d. Repeat steps a through c to lock the remaining mounting levers in 
their final position.

IMPORTANT Do not use tools or excessive force to rotate the mounting lever. The 
mounting levers are rotated and secured by hand. 

TIP A broken mounting lever does not damage the terminal.
If a mounting lever is over torqued, the lever is designed to break 
off the pin. This breakage helps to prevent damage to the 
terminal bezel. If a pin is broken, turn the mounting lever over 
and use the other pin to continue the installation. See Figure 3 on 
page 29 for details and restrictions.

6 1 6
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8. To make sure each is in the correct locked position, inspect all mounting 
levers.

The notch on the outside of mounting lever shows its locked position. 

This view shows that the mounting levers are locked in position 1.

ATTENTION: All mounting levers must be in the correct locked 
position and follow the correct lever installation sequence to provide 
an adequate gasket seal between the terminal and the panel. 
Rockwell Automation assumes no responsibility for water or 
chemical damage to the terminal or other equipment within the 
enclosure because of improper installation.

61

666

Series B terminal with dual 
Ethernet ports shown. 
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Remove and Replace Power 
Terminal Block

The product has a three-pin terminal block for power connections. You can 
remove the terminal block for ease of installation, wiring, and maintenance.

Use a 0.6 x 3.5-mm flat blade screwdriver for terminal block wiring.

To remove the power terminal block, follow these steps.

1. Loosen the two screws that secure the terminal block.

2. Gently pull the terminal block away from the connector.

To install the power terminal block, follow these steps.

1. Press the terminal block onto the connector until seated.

2. Tighten the two screws that secure the terminal block to the connector.

WARNING: Explosion Hazard
If you connect or disconnect wiring while the power is on, an electric arc can 
occur. This arc can cause an explosion in hazardous location installations. Make 
sure that the power is off and the area is nonhazardous before proceeding.
Failure to turn power off can result in electrical shock or damage to the 
terminal.

Table 15 - Wire Specifications for Power Input Terminal Block

Wire Type Dual-wire Size(1)

(1) Two-wire maximum per terminal.

Single-wire Size Strip Length Screw Torque

Stranded or solid
Cu 90 °C (194 °F)

0.3…1.3 mm2

22…16 AWG
0.3…2.1 mm2

(22…14 AWG) 7 mm (0.28 in.) 0.56 N•m (5.0 lb•in)

666

Series B terminal with dual 
Ethernet ports shown. 

ATTENTION: Do not use excessive force to press the DC terminal 
block into position. The DC terminal block is keyed to fit the DC 
connector. If the terminal block does not fit into the connector, verify 
that you have the correct DC terminal block. See Table 5 on page 17. 
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Connect Power The terminals have a 24-V DC non-isolated power supply at these power 
ratings:

• 24V DC nominal (18…30V DC)
• 35 W maximum (1.46A at 24V DC)

The terminals support operation from a safety extra low voltage (SELV) or 
protective extra-low voltage (PELV) 24V DC power supply. Supported power 
supplies include catalog numbers 1606-XLP95E, 1606-XLP100E, and 
2711P-RSACDIN.

To power the terminal from the same power source as other equipment, use a 
DC power bus.

To connect the operator terminal to a DC power source, follow these steps.

1. Verify that the wiring is not connected to a power source.

2. Strip 7 mm (0.28 in.) of insulation from your power supply wires.

3. Secure the DC power wires to the marked terminals (+ and –) on the 
terminal block.

4. Secure the earth ground wire to the GND terminal on the terminal 
block.

The GND terminal must be connected to a low-impedance earth 
ground.

ATTENTION: The power supply is internally protected against reverse 
polarity. Connecting DC+ or DC- to the earth ground terminal can damage 
the terminal. Connecting AC power, or more than 30V DC, can also damage 
the terminal.

ATTENTION: Use a SELV or PELV supply as required by local wiring codes for 
your installation. The SELV and PELV power sources provide protection so 
that under normal and single fault conditions, the voltage between 
conductors and earth ground does not exceed a safe value.

7 mm
20 mm

6 6 6

GNDDC+ DC–

Series B terminal with dual 
Ethernet ports shown. 
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5. Apply power to the operator terminal.

Connect to a Network The Ethernet port or ports connect to controllers on an EtherNet/IP network 
by using standard Ethernet connections. These types of networks are 
supported:

• Device Level Ring Network Topology on page 37
• Linear Network Topology on page 38
• Star Network Topology on page 39

Each of these EtherNet/IP network topologies supports applications that use 
Integrated Motion over an EtherNet/IP network, if necessary. See the 
EtherNet/IP Embedded Switch Technology Application Technique, 
publication ENET-AP005, for more information.

Ethernet Ports

The Ethernet ports have one or two 10/100Base-T connectors for network 
communication and supports MDI/MDI-X connections and DLR network 
topology as indicated by the DLR network icon.

The terminal connects to an EtherNet/IP network by using a CAT5, CAT5E, 
or CAT6 twisted-pair, Ethernet cable with RJ45 connectors.

ATTENTION: The earth ground connection to ground is mandatory. 
This connection is required for noise immunity, reliability, and 
Electromagnetic Compliance (EMC) with the European Union (EU) 
EMC Directive for CE marking conformance. This connection is 
required for safety by Underwriters Laboratory (UL).

IMPORTANT Secure the power cable to prevent these actions: 
• Vibration at the connector.
• Pulling when the panel door is opened and closed, or when 

personnel are working inside the panel.

IMPORTANT Series B terminals can have dual Ethernet ports, but only one device IP 
address.

Link 2 Link 1

Series B terminal with dual 
Ethernet ports shown. 

6 6 6

Ethernet Ports
Link 1Link 2
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The maximum cable length between the Ethernet ports and a 10/100Base-T 
port on an Ethernet hub (without repeaters or fiber) is 100 m (328 ft).

The Ethernet port has two indicators that provide the status of activity.

Device Level Ring Network Topology

A DLR network is a single-fault tolerant ring network that is intended for the 
interconnection of automation devices. This topology is also implemented at 
the device level. No additional switches are required.

IMPORTANT To help prevent accidental disconnection of the Ethernet cable, follow these 
steps: 
• To minimize vibration at the connector, and reduce the chance that 

personnel working inside the panel can accidentally disconnect the 
cable, secure the Ethernet cable.

• To prevent pulling on the cable when the panel door is opened and 
closed, do not install the Ethernet cable too tightly. Leave some slack in 
the cable.

WARNING: Do not connect or disconnect any communication cable with 
power applied to this device or any device on the network. An electric arc 
can cause an explosion in hazardous location installations. Make sure that 
the power is off or the area is nonhazardous before proceeding.

Table 16 - Ethernet Connector Pinout

Connector Pin Pin Name

View of RJ45 
Connector

1 TD+

2 TD-

3 RD+

4 Unused

5 Unused 

6 RD-

7 Unused

8 Unused

Shield connection No direct connection
(AC coupled to chassis GND)

Table 17 - Ethernet Status Indicators

Indicator Color Description

Link integrity Green On, when a link is present.

Activity Yellow Blinks when activity is detected on Ethernet link. 

TIP A DLR network has supervisor nodes and ring nodes. The PanelView Plus 7 
Standard terminal operates only as a ring node on the network.

1 8

Yellow 
Status 

Indicator

Green 
Status 

Indicator
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Only PanelView Plus 7 standard terminals with two Ethernet ports, for 
example, catalog number 2711P-T10C22D8S, operate on a DLR network.

DLR network topologies automatically convert to linear network topologies 
when a fault is detected. The conversion to the new network topology 
maintains communication of data on the network. The fault condition is 
typically detected and corrected.

For more information on DLR network topology, refer to EtherNet/IP 
Embedded Switch Technology Application Guide, publication ENET-AP005.

Figure 4 - PanelView Plus 7 Standard Terminal in a DLR Network

Linear Network Topology

A linear network topology is a collection of devices that are daisy-chained 
together across an EtherNet/IP network. Devices that can connect to a linear 
network topology use embedded switch technology to eliminate the need for a 
separate switch, as required in Star network topologies.

1794-AENTR FLEX™ I/O Adapter 
with FLEX I/O Modules

1734-AENTR POINT I/O™ Adapter 
with POINT I/O Modules

Kinetix® 6500 Drives 
with Motors

PowerFlex® 755 Drive Connected 
Via a 1783-ETAP EtherNet/IP Tap

1769-L18ERM-BB1B Control System

Computer Connected Via a 
1783-ETAP EtherNet/IP Tap 1756-ControlLogix Controller

PanelView Plus 7 Standard 
Terminal Connected Via Two 

Ethernet Ports

TIP The PanelView Plus 7 Standard terminal with one Ethernet port can be 
attached only at the ends of the linear network.
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Figure 5 - PanelView Plus 7 Standard Terminal at the End of a Linear Network

Star Network Topology

A star network topology is a traditional EtherNet/IP network that has 
multiple devices that are connected to each other via an Ethernet switch.

Figure 6 - PanelView Plus 7 Standard Terminal Connected Via a Stratix 6000 Switch

PanelView Plus 7 Standard Terminal

Kinetix 350 Drive Connected 
Via a 1783-ETAP EtherNet/IP Tap

Kinetix 350 Drive Connected 
Via a 1783-ETAP EtherNet/IP Tap

1769-L27ERM-QBFC1B
Control System

1794-AENTR FLEX I/O Adapter 
with FLEX I/O Modules

1734-AENTR POINT I/O Adapter 
with POINT I/O Modules

Computer

Computer

Stratix 6000™ Switch

1734-AENTR POINT I/O Adapter 
with POINT I/O ModulesKinetix 350 Drive

Kinetix 350 Drive

1769-L27ERM-QBFC1B
Control System

PanelView Plus 7 Standard Terminal
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Initial Startup The first time that you start the system, the terminal goes through its start-up 
sequence and launches FactoryTalk View ME Station in Configuration mode.

To change the action that occurs at startup, press Terminal Settings, then tap 
Startup Options. You can configure one of these options:

• Launch a FactoryTalk View ME HMI application.
• Launch FactoryTalk View ME Station in Configuration mode (default).
• Launch the Windows desktop.

For more information on how to change the start-up option and desktop 
access, see Chapter 3, Configure Terminal Settings.

Reset the Terminal There are several ways to restart the terminal without having to disconnect and 
reapply power:

• From FactoryTalk View ME Station Configuration Mode, tap Reset.
• From the terminal desktop Start Menu, choose Programs>Restart 

System.
• To access Maintenance Mode, follow these steps.

a. Plug in a USB keyboard.
b. Press and hold the white box that appears in the bottom left corner 

when the terminal is booting up.

Refer to Maintenance Mode Operations on page 143 for details on how to 
restart the terminal from Maintenance Mode.

EXAMPLE Terminals are initially shipped with desktop access disabled. You can 
configure your terminal to allow desktop access.
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FactoryTalk View ME Station FactoryTalk® View ME Station is the runtime environment of the terminal. 
This environment lets you configure start-up options, load and run HMI 
applications, adjust terminal settings, access the Windows desktop, and 
perform other terminal operations.

When you reset the terminal, one of these actions occurs depending on the 
configured start-up option:

• FactoryTalk View ME Station launches in Configuration mode. This 
mode is the initial default.

• FactoryTalk View ME .mer application runs.
• Windows desktop launches. 

Topic Page Topic Page

FactoryTalk View ME Station 41 Display Settings 61

Terminal Settings 43 Input Device Settings 63

Soft Keyboard 44 Configure Print Options 65

Load and Run an Application 45 Configure Diagnostics 67

Desktop Access 46 Check Integrity of Application Files 68

Configure Start-up Options 51 View and Clear the System Event Log 69

Configure Controller Address 54 Enable or Disable the Alarm Display 69

Configure Ethernet Settings 54 Display System Information 70

Modify Device Name of Terminal 58 Time and Date Settings 73

Copy Files on Terminal 59 Regional Settings 75

Delete Files from Terminal 60

IMPORTANT • To access Configuration mode from an HMI application on the terminal, 
press Goto Configuration Mode. This button is added to application 
screens in FactoryTalk View Studio software during application 
development. The application stops running but is still loaded.

• If your application does not have a Goto Configuration Mode button, 
refer to Enter Configuration Mode on Startup on page 52 for details on 
how to access Configuration mode.

• To access Configuration mode from the Windows desktop, double-click 
the FTViewME Station icon .
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Figure 7 - FactoryTalk View ME Station Dialog Box

Table 18 - Terminal Operations

Press To

Load Application [F1] Open a dialog box where you select a .mer application to load in the 
device. You must load an application before you can run it.
The name of the loaded application appears under Current 
Application.

Run Application [F2] Run the .mer application that is loaded in the terminal.

Application Settings [F3] Open a menu of application-specific settings, such as device shortcuts 
defined for the loaded .mer application. Device shortcuts are 
read-only.
For example, CLX is the device shortcut for a ControlLogix® controller.

Terminal Settings [F4] Open a menu of options to modify terminal settings.

Delete Log Files Before Running [F5] Toggle between Yes and No. 
• Select Yes to delete all data log files, alarm history, and alarm 

status files before running the application. 
• Select No to run the application without deleting log files.

Reset [F7] Reset the terminal and launch an HMI application, FactoryTalk View 
ME Station software, or the Windows desktop. The action that occurs 
depends on the configured startup-option. 

Exit [F8] Exit FactoryTalk View ME Station. If desktop access is allowed, you can 
access the desktop.

Device, IP Addr, Subnet
(display only)

Identifies the device name, IP address, and subnet of the terminal on a 
connected Ethernet network. 
The network information is updated every 60 seconds. If the terminal 
is disconnected from the network, the IP address and subnet appear 
as 0.0.0.0.
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Terminal Settings The terminal has settings that you can adjust that are not specific to the 
application.

1. Press Terminal Settings from the FactoryTalk View ME Station dialog 
box.

2. Select an option by touching the up and down cursors.

3. Press Enter to access selected function.

Table 19 - Terminal Settings

Select This Option  If You Want To

Alarms Close the alarm display on the terminal when an operator acknowledges the newest alarm. By default, the alarm display is closed.

Diagnostics Setup Edit the location where diagnostic messages are saved and determine what kind of messages are saved. 

Display Adjust the brightness of the display, configure the screen saver, and enable/disable the touch screen cursor.

Desktop Access Setup Allow or restrict access to the desktop. Set or reset the desktop password.

File Management Copy application files and font files to the terminal, an SD card, or a USB drive. You can also delete application files, log files, and font 
files.

Font Linking Link a font file to a base font loaded on the terminal.

Input Devices Configure settings for the keypad, attached keyboard, mouse, or touch screen, including touch screen calibration. You can also choose 
between a pop-up character input or pop-up keyboard for string input.

File Integrity Check Check the integrity of the .mer application file and runtime files by logging details to a file integrity check log. You can view and clear 
this log at any time.

Networks and Communications Configure Ethernet and other communication settings for an application.

Print Setup Configure settings that are used to print displays, alarm messages, or diagnostics messages that the application generates.

Startup Options Specify whether the terminal launches the desktop, an application, or FactoryTalk View ME Station Configuration mode on startup. 

System Event Log Display system events, and clear events from the log.

System Information Display power, battery, and memory details for the terminal. You can also view the firmware revision for FactoryTalk View ME Station, 
and other software that is loaded on the terminal. Technical support information.

Time/Date/Regional Settings Set the date, time, language, and numeric format that is used by terminal and applications. 
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Soft Keyboard When you activate a data entry field on the terminal, a keyboard opens. For 
fields that require only numeric values, 0…9 and the decimal is enabled.

Follow these steps to enter characters in the display area above the keyboard:

1. Select a character on the keyboard by touching a key.

2. Press Enter when done to exit the keyboard.

Table 20 - Soft Keyboard Controls

Select this key: To:

SHF Switch keys between their shifted and unshifted state.

CAP Switch between lowercase and uppercase characters. 

SPACE Enter a space between characters in the display area.

Backspace Delete the previous character (to the left of the cursor) in the display area.

Select Enter a selected character into the display area.

Left, right, up, down arrow Select the character to the left, right, above, or below the currently selected 
character.

Enter Accept the entered characters and return to the previous dialog box.

ESC Cancel the current operation and return to the previous dialog box.
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Load and Run an Application To run a FactoryTalk View ME .mer application on the terminal, you must first 
load the application. You can load the application from internal storage 
(nonvolatile memory) in the terminal, an SD card, or a USB drive.

Follow these steps to load and run an application on the terminal.

1. Press Load Application from the FactoryTalk View ME Station dialog 
box.

2. To select the location of the file to load, press Source:
• Internal Storage – nonvolatile memory of the terminal.
• External Storage 1 – an SD card is loaded in the card slot.
• External Storage 2 – a USB drive is loaded in the USB host port.

3. To select a .mer file from the list, use the up and down cursor keys.

4. To load the selected application, press Load.

You are asked if you want to replace the current communication settings 
of the terminal with the settings defined in the application. 

5. Select Yes or No.
• To use the communication settings in the application, select Yes.

The application settings replace the communication settings that are 
configured for the terminal.

• To use the communication settings of the terminal, select No.

The application loads and its name appears at the top of the FactoryTalk 
View ME Station dialog box.

6. To run the application that loaded, press Run Application on the 
FactoryTalk View ME Station dialog box.

TIP The path for Machine Edition files on the terminal is
My Device\Application Data\Rockwell Software\RSViewME\Runtime.
The path for Machine Edition files on the SD card or USB drive is 
\Rockwell Software\RSViewME\Runtime.
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Desktop Access You can allow or restrict access to the desktop on the terminal. From the 
desktop, you can perform system and control panel operations. You can allow 
access temporarily, then disable desktop access to prevent unauthorized 
changes.

With restricted access, you must enter a password to access the desktop. Each 
terminal has a default password and a challenge question. 

Enable Desktop Access

Follow these steps to enable desktop access.

1. Press Terminal Settings, then choose Desktop Access Setup.

2. To select Allow, press Desktop Access.

The Enter Password dialog box opens. 

Each time that you change desktop access from disallow to allow, you 
must first enter a password. The initial default password is ‘password’. 

3. To type the password, then press Enter, press Password.

4. To return to Desktop Access Management, press Enter again.

TIP Applications generate log files. You can delete log files from the FactoryTalk 
View ME Station dialog box before running the application. Delete log files 
to reclaim memory in the terminal. 
Refer to Run the Loaded Application on Startup on page 53 to set the 
application to run on startup or reset.

TIP Terminals are shipped from the factory with desktop access disabled.

Default Password Credentials Values

Password password (case sensitive)

Challenge question What is the opposite of lock?

Challenge answer unlock (case sensitive)

IMPORTANT Rockwell Automation recommends that you change the default password 
and challenge question and answer to something unique for your 
installation.
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Notice the password is no longer set.

5. To exit terminal settings and return to the FactoryTalk View ME Station 
dialog box, press OK to exit Desktop Access Management, then Close.

6. To access the desktop, press Exit.

When desktop access is enabled, you are not required to enter a 
password.

Disable Desktop Access

To restrict desktop access requires that you define a desktop password and 
challenge question:

• The password lets you access the desktop from FactoryTalk View ME 
Station when pressing Exit.

• The challenge question and response lets you change the password with 
the Reset function.

Follow these steps to disable desktop access.

1. Press Terminal Settings, then choose Desktop Access Setup.

2. Press Desktop Access and select Disallow.

The Set Password button is enabled.

IMPORTANT To restrict desktop access, the start-up option must be set to either Go to 
Configuration Mode or Run Current Application. See page 51 for details.
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3. Refer to Set a Desktop Password on page 49 to define a new password 
and challenge question.

IMPORTANT If an error message displays, you can change the startup option to 
Go to Configuration Mode or Run Current Application.
You cannot restrict access to the desktop if Startup Options is 
configured for Do not start FactoryTalk View ME Station.
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Set a Desktop Password

Follow these steps to define a new desktop password.

1. Press Set Password.

The Desktop Access Set Password dialog box opens.

2. Press Set Password, enter an 8…20 character password, then press Enter.

3. Press Set Challenge to enter a challenge question that you must correctly 
respond to when resetting the desktop password.

4. Press Set Response to enter a response to the challenge question, then 
press Enter.

5. Press OK. 

The Desktop Access Management Dialog shows that a password and 
challenge question are set.

6. Press OK to return to terminal settings.

IMPORTANT When you restrict access to the desktop, you must define a new password 
and challenge question.

IMPORTANT You must correctly enter this password before accessing the 
desktop.

IMPORTANT Secure your password and challenge question for future use. To clear and 
reset the password, you must correctly respond to the challenge question. If 
you forget the response, the only way to clear the password is to restore the 
factory default settings on the terminal. See Factory default on page 143.
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Reset the Desktop Password

To clear and change the current password, you must correctly respond to the 
current challenge question. If you do not remember the response, you must 
restore the terminal to its factory defaults. Refer to Maintenance Mode 
Operations on page 143. 

Follow these steps to reset the desktop password.

1. Press Reset Password from the Desktop Access Management dialog box.

2. Press Answer Challenge and enter the correct response to the current 
challenge question.

3. Press Clear Password to clear the current password and challenge 
question.

The dialog box shows the updated status of the password and challenge 
information.

4. Press Close.

5. Refer to Set a Desktop Password on page 49 to set a new password and 
challenge question.

After clearing the password, you must set a new desktop password or 
change the desktop access to ‘Allow’.

IMPORTANT You can reset the password and challenge questions if access to the desktop 
is restricted or set to disallow.
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Configure Start-up Options You can specify what action the terminal takes on startup or a reset.

Disable FactoryTalk View ME Station on Startup

To launch the desktop on startup, you must disable FactoryTalk View ME 
Station. 

Follow these steps to disable FactoryTalk View ME Station on startup.

1. Press Terminal Settings, then choose Startup Options.

2. Press On Startup until ‘Do not start FactoryTalk View ME Station’ is 
selected.

3. Press OK.

This Start-up Option Performs This Action Typical System

Do not start FactoryTalk View 
ME Station

Launches the Windows desktop on startup. Open

Go to Configuration Mode Launches FactoryTalk View ME Station in Configuration 
mode on startup. This mode is the initial, factory default 
setting.

Closed

Run Current Application Runs the FactoryTalk View ME application that is loaded in 
the terminal on startup.

Closed

IMPORTANT When desktop access is restricted, the start-up option must be set to Run 
Current Application or Go to Configuration Mode (default). See page 46 for 
details on how to allow or restrict desktop access.

TIP You can also launch the desktop by pressing Exit on the FactoryTalk View 
ME Station dialog box. 

TIP Desktop access must be set to allow or you get a warning. See 
enable desktop access on page 46.
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Enter Configuration Mode on Startup

Follow these steps to launch FactoryTalk View ME Station in Configuration 
mode on startup.

1. Press Terminal Settings, then choose Startup Options.

2. To select Go to Configuration Mode, press On Startup.

3. To view or change optional settings, press Configuration Mode Options.

4. To specify whether you want to load the current application on startup, 
press Load Current Application.

5. To specify what configuration settings are used when the loaded 
application is run, press Replace RSLinx® Enterprise Communications:
• To use the RSLinx communication settings in the terminal, select 

No.
• To replace the terminal settings with the communication settings in 

the application, select Yes. Any changes to RSLinx device addresses or 
driver properties on the terminal are lost.

6. To return to the previous dialog box, press OK.

7. To return to terminal settings, press OK.
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Run the Loaded Application on Startup

Follow these steps to run the FactoryTalk View .mer application that is loaded 
in the terminal on startup.

1. Press Terminal Settings, then choose Startup Options.

2. To select Run Current Application, press On Startup.

3. To view or change optional settings, press Run Options.

If the application is not loaded, the options are disabled.

4. Press Replace RSLinx Enterprise Communications to specify what 
configuration settings are used when running the application:
• To use the RSLinx communication settings in the terminal, select 

No. 
• To replace the terminal settings with the communication settings in 

the application, select Yes. Any changes to RSLinx device addresses or 
driver properties on the terminal are lost. 

5. To specify what action to take with the log files on startup, press Delete 
Log Files On Every Power Cycle:
• To delete all log files (data, alarm history, alarm status) generated by 

the terminal before running the application, select Yes. The files are 
deleted from the system default location.

• To retain all log files, select No.

6. To return to the previous dialog box, press OK.

7. To return to terminal settings, press OK.



54 Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015

Chapter 3 Configure Terminal Settings

Configure Controller Address To configure communication information for your application and controller, 
use RSLinx Enterprise software.

To edit the device address of the controller, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>RSLinx Enterprise Communications.

2. Select the controller in the tree.

3. To view the device name and current address, press Edit Device.

4. To modify the address, press Device Address.

The input panel opens with the current address.

5. Enter the address in the input panel and press Enter.

6. Press OK.

Updates do not take effect until the terminal is restarted.

Configure Ethernet Settings The terminal has a built-in Ethernet driver. You can modify the following 
Ethernet information for your device:

• IP address of terminal on network, including link speed
• Device name that identifies terminal on network
• User name and password to access network resources
• Enable or disable either Ethernet port to configure for DLR, star, or 

linear network topologies

TIP You can also configure communication information for your application 
and controller by using FactoryTalk View Studio software.
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Set the Ethernet Address of the Terminal

Some networks automatically assign an IP address to Ethernet devices if 
dynamic host configuration protocol (DHCP) is enabled. If DHCP is 
disabled, you can manually enter an IP address.

To view or enter an IP address for your terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To view or modify the IP address, press IP Address.

3. To enable or disable DHCP assignment of addresses, press Use DHCP.
• If DHCP is enabled or set to Yes, IP addresses are automatically 

assigned to newly attached devices on the network.
• If DHCP is disabled or set to No, you can manually enter the IP 

address. Press IP Address, Subnet Mask, and Gateway to enter IP 
formatted addresses.

4. Press OK when done.

If prompted, reset the device from the FactoryTalk View ME Station 
dialog box.

5. Press Close.

TIP • IP Address – The format of the IP address is xxx.xxx.xxx.xxx; for 
example, 192.168.124.96. The first set of decimal numbers is in the 
range 1…255; the last three sets are in the range 0…255. The default 
is 000.000.000.000. 

• Subnet Mask – Address must be identical to the server subnet mask. 
• Gateway – optional address.
• MAC ID – read-only field.
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Set the Ethernet Link Speed

You can change the rate and mode for how data is transmitted on the Ethernet 
network. The default setting is Auto. The Auto option automatically 
configures the speed of the device to match the speed on the local network.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To access the Ethernet link settings, press Settings.

3. To change the rate that data is transmitted at over the Ethernet network, 
press Ethernet Configuration.

4. To return to the Network Adapters dialog box, press OK.

Configure the Ethernet Ports

To configure the Ethernet ports of the terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To access the Ethernet link settings, press Settings.

3. To enable or disable the ports that you want to use for your network 
configuration, press Ethernet Link1 and Ethernet Link2.

TIP The Auto option is preferred because it determines the actual speed and 
duplex setting of the connected device on the Ethernet network.
If you select a manual option, make sure that the speed and duplex setting 
for the connected device on the Ethernet network is identical. If the 
settings are not identical, there can be decreased network performance 
and errors. 
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4. To select Auto, press Ethernet Configuration.

5. To save the configuration, press OK.

6. For the changes to take effect, restart the terminal.

You can also configure the Ethernet ports as a system default for a closed 
system. See Configure the Ethernet Ports on page 111.

Name the Server Addresses

You can name the server addresses for the EtherNet/IP network adapter. These 
addresses are automatically assigned if DHCP is enabled for the adapter.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. Press Name Servers.

3. To enter a corresponding name server address, press a button.

4. Press OK when done.
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Modify Device Name of 
Terminal

Each terminal has a unique name that identifies it on the network. 

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Device Name.

2. To edit the default device name, press Device Name.

3. To modify the description for the device, press Device Description.

4. Press OK.

TIP The device name has 1…15 characters:
• The first character must be an upper or lowercase letter a…z, A…Z.
• The other characters can be a…z, A…Z, 0…9, or - (hyphen).

TIP The description is a maximum of 50 characters. The default description is 
Rockwell Automation plus the device catalog number.
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Copy Files on Terminal You can copy FactoryTalk View ME .mer application files or font files between 
nonvolatile memory of the terminal and a USB drive, or SD card. 

1. Press Terminal Settings, then choose File Management>Copy 
Files>Copy Applications or Copy Fonts.

2. To select the location of the file you want to copy, press Source:
• Internal Storage – nonvolatile memory of the terminal.
• External Storage 1 – SD card that is loaded in card slot of terminal.
• External Storage 2 – USB drive that is loaded in USB host port of 

terminal.

3. Select a file that appears in the list for the selected storage area.

4. Press Destination on the same dialog box.

5. To select the storage location to copy the file, press Destination. 

The destination must be different than the source location.

6. To copy the selected file to the target location, press Copy.

If the file exists, you are asked if it is okay to overwrite the file. Respond 
by selecting Yes or No.

TIP If you are saving files to the terminal, be sure to save the .mer files to 
My Device\Application Data\Rockwell Software\RSViewME\Runtime\ 
and save font files to \Rockwell Software\RSViewME\Fonts\.
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Delete Files from Terminal You can delete FactoryTalk View ME application .mer files or font files that 
reside in nonvolatile memory of the terminal, a USB drive, or an SD card.

1. Press Terminal Settings, then choose File Management>Delete 
Files>Delete Applications or Delete Fonts.

2. To select the storage location of the application or font file you want to 
delete, press Source:
• Internal Storage – nonvolatile memory of the terminal.
• External Storage 1 – SD card that is loaded in card slot of terminal.
• External Storage 2 – USB drive that is loaded in USB host port of 

terminal.

3. Select a file that appears in the list for the selected storage area.

4. Press Delete.

5. Select Yes or No when asked if you want to delete the selected 
application or font file.

Delete Log Files

You can delete log files, alarm history files, and alarm status files from the 
System Default location of the terminal. The application generates the files 
during runtime.

1. Press Terminal Settings>File Management>Delete Files>Delete Log 
Files.

You are asked to confirm the deletion of the files.

Do you want to delete the FactoryTalk View ME Station Log Files?

2. Select Yes or No.

Log files not in the System Default location are not deleted.
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Display Settings For the terminal display, you can change its brightness, configure the screen 
saver, or disable the screen cursor.

Adjust Display Intensity

You can adjust the intensity of the backlight in 10% increments from 1…100%. 
At 0%, the backlight is minimally visible. You can use the default intensity of 
100% or adjust the intensity for runtime operations. 

1. Press Terminal Settings, then choose Display>Display Intensity.

2. To switch between Default intensity and Runtime intensity, press 
Startup Intensity.
• If you select Runtime, the start-up screens use the runtime intensity.
• If you select Default, the start-up screens use the default setting of 

100%.

3. Increase or decrease the intensity for runtime operations by pressing the 
up or down cursors.

4. Press OK when done to save changes.
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Configure the Screen Saver

A screen saver image appears on the terminal display when no user activity is 
sensed for a certain time. The default idle time is 10 minutes. You can adjust 
the idle time and intensity level of the screen saver, disable the screen saver, or 
disable the screen saver image.

1. Press Terminal Settings, then choose Display>Screen Saver.

2. To change the idle period for activating the screen saver, press Screen 
Saver.

To disable the screen saver, select Disabled.

3. To increase or decrease the brightness intensity of the screen saver, press 
the up and down cursors.

4. To access the screen saver image setting, press Advanced Settings.
a. To disable or enable the current screen saver, press Screen Saver 

Image. See page 89 for details on how to change the screen saver 
image.

b. To return to the Screen Saver dialog box, press OK.

5. To exit and return to terminal settings, press OK.

Disable the Screen Cursor

The terminal has a screen cursor that you can disable or enable.

1. Press Terminal Settings, then choose Display>Cursor.

2. To disable or enable the cursor, press Enable Cursor.

3. To exit and return to terminal settings, press OK.
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Input Device Settings You can adjust settings for input devices that are used by the terminal including 
the touch screen and string entry popup.

Calibrate the Touch Screen

To calibrate the touch screen, follow these steps. 

1. Press Terminal Settings, then choose Input Devices>Touch 
Screen>Calibration.

2. Follow the instructions on the screen.

When the calibration is complete, a message appears to indicate the 
measurement of new calibration settings. You can do one of the 
following:
• To register saved data, press the screen.
• To cancel saved data and keep the current settings, wait for 30 

seconds.

IMPORTANT Use a plastic stylus with a minimum tip radius of 1.3 mm (0.051 in.) A 
stylus is more precise than a finger and also protects the screen.

Carefully press and briefly hold stylus on the center of the target.
Repeat as the target moves around the screen.
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Set the Double-tap Sensitivity for a Touch Screen

You can set and test the sensitivity of both speed and physical distance between 
touch screen presses. 

1. Press Terminal Settings, then choose Input Devices>Touch 
Screen>Double Tap Sensitivity.

2. To set the sensitivity of touch screen presses, double-tap Set.

3. To test the sensitivity of touch screen presses, double-tap Test.

The Test button reverses its foreground and background colors.

4. Press OK when done.

Change the Popup for String Entry

You can use a string popup for character input instead of the popup keyboard 
or input panel.

1. Press Terminal Settings, then choose Input Devices>String Popup.

2. To select the preferred method for character input, press ‘Invoke pop-up 
character input instead of pop-up keyboard’.

3. Press OK.

TIP The process is identical to set and test the sensitivity of mouse clicks. To 
adjust the sensitivity of mouse clicks, press Terminal Settings, then choose 
Input Devices>Mouse.
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Configure Print Options You can configure settings for print displays, alarm messages, or diagnostic 
messages from FactoryTalk View ME applications. The setup for print displays 
and messages is the same. Advanced settings are different.

PanelView Plus 7 Standard terminals support selected printers. For a list of 
supported printers, go to http://www.rockwellautomation.com/
knowledgebase and search the Knowledgebase for keywords ‘Printers 
Supported on PanelView Plus’.

Printer installation is plug-and-play. Supported printers are automatically 
mapped to the appropriate driver. Printers that do not configure automatically 
to the appropriate driver can be installed manually. 

Follow these steps to access the print setup.

1. Press Terminal Settings, then choose a Print Setup> option:
• Alarm Print Setup
• Diagnostic Setup
• Display Print Setup

The Print Setup dialog box shows installed printers that are available to 
the FactoryTalk View ME application. The list of printers that shows 
depends on what printers you install.

The terminals are not shipped with pre-configured printers so initially 
the dialog box is empty. 

2. Select an installed printer.

TIP The printer that you select must be in the control panel Printers applet.
A failed attempt to install a printer is reported in the system event log.
Use the control panel in Windows Explorer to install a printer that does not 
install automatically.
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3. To access these options, press Advanced Settings:
• Options for print displays include print orientation, draft mode, and 

color.
• Options for print diagnostic and alarm messages determine when to 

print messages that are sent to the network or USB port.

4. Press OK when done.

5. To return to terminal settings, press OK.

Print Messages After Default Value Example

Specified number of messages 60 messages When the queue has 60 messages, the messages are printed regardless of 
how long they have been in the queue.
You can change the number of messages.

500 messages or timeout period, whichever is 
first

168 hours (7 days) If the queue has 350 messages after 168 hours, the 350 messages are 
printed.
You can change the timeout period.

Specified number of messages or timeout period, 
whichever is first.

60 messages
168 hours (7 days)

If the queue has 60 messages after 24 hours, then the 60 messages are 
printed.
You can change the number of messages and the timeout period.

For example, the number of messages is set to 75 and the timeout period is 
set to 48 hours.

• If the queue has 75 messages after 24 hours, then the 75 messages are 
printed before the set timeout of 48 hours.

• If the queue has 15 messages after 48 hours, the 15 messages are printed 
after the set timeout period.
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Configure Diagnostics You can log diagnostics to a remote computer for troubleshooting. 

To configure and forward diagnostics to a computer, follow these steps.

1. Press Terminal Settings, then choose Diagnostic Setup.

A list of diagnostic nodes appears.

The Remote Log destination forwards messages to a Windows computer that 
runs diagnostics. The IP address and port number identify the computer. 

Select Message Routing to access the following dialog boxes:
• Remote Log
• FactoryTalk View Diagnostics List

Each dialog box shows a list of messages that can be sent to a destination. 
Cursor to a message, then press On/Off to enable or disable the message. 
Messages with checked boxes are enabled. Messages with cleared boxes are 
disabled. 

Audit Message Logging lets you log messages as Audit or Information.

TIP To access Remote Log or Message Routing setup, select the node 
then press Edit.

Field Description Valid Values

Address IP address of the remote Windows computer. xxx.xxx.xxx.xxx

Port The port that is used to communicate with the remote Windows computer. 4445 (default)
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Check Integrity of 
Application Files

It is good practice to check the integrity of the .mer application that is loaded 
in the terminal and the runtime files. Errors, warnings, and information 
messages are logged to a file. You can view the log and clear items from the log. 

1. Press Terminal Settings, then choose File Integrity Check.

2. Press either of the Enable options to disable integrity checks of the .mer 
application or the runtime files.

Integrity checks are automatically performed on the application .mer file 
and runtime files. If you disable either of these functions, the files are not 
checked and the log file is not updated.

3. Press OK to save changes.

Follow these steps to view the log generated by runtime files.

1. Press View Log from the File Integrity Check dialog box.

2. To display details for that event, select an event and press More Details.

3. To clear all details from the log, press Clear All.

4. To return to previous dialog box, press Close.

TIP Runtime files enable applications to run on the terminal. If the terminal is 
not functioning correctly, a review of the logs can identify an error in a 
runtime file.
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View and Clear the System 
Event Log

The System Event Log displays warnings, errors, and events logged by the 
terminal. The log provides a time stamp of when each event occurred and text 
that describe the event. If the event log is full when a new event occurs, the 
oldest entry is removed to accommodate the new event.

1. Press Terminal Settings>System Event Log.

2. To display details for the event, select an event then press More Details.

3. To clear all events in the log, press Clear All.

4. Press Close.

Enable or Disable the Alarm 
Display

The terminal displays each alarm as it occurs in the alarm display or alarm 
banner. When the operator acknowledges the most recent alarm, the alarm 
display closes or remains open. The default is to close the alarm display. 

1. Press Terminal Settings, then choose Alarms.

2. To toggle between Yes or No, press ‘Close Alarm Display When Newest 
Alarm Acknowledged’. 
• Yes closes the alarm display when the newest alarm is acknowledged.
• No leaves the alarm display open when newest alarm is 

acknowledged. 

3. Press OK.
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Display System Information You can view terminal and firmware revision information for software that is 
installed on a terminal.

View Terminal Information

You can view the following information:
• Total power on time in minutes
• Battery voltage and state
• Memory that is allocated and in use
• Random access memory (RAM) usage during runtime

To view status information for your terminal, follow these steps.

1. Press Terminal Settings, then choose System Information>Terminal 
Information.

.

• Battery voltage must be at least 2.75V DC. 

Battery State Description

GOOD Good battery condition.

FAILING Low battery. Replace the battery.

BAD Battery is missing or bad. Replace the battery.
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2. To view information for the Program RAM and Available Flash 
(nonvolatile) memory, press Memory Allocation. 

3. To return to previous dialog box, press Close.

4. To view the RAM used by the application at runtime, press Runtime 
RAM Usage.

This information can be helpful if you are troubleshooting problems 
that are related to RAM usage.

5. To return to the previous dialog, press OK.

6. Press Close until you return to terminal settings.
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View FactoryTalk View ME Station Information

You can view firmware and version information for components that are 
installed on your terminal and access technical support information.

1. Press Terminal Settings, then choose System Information>About 
FactoryTalk View ME Station.

2. To display the support phone number and website, press Technical 
Support.

3. Press Close until you return to terminal settings.
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Time and Date Settings You can change the time zone, date, time, and regional settings for terminal 
operations. 

Change the Time Zone on the Terminal

You can view or modify the current time zone on the terminal. Time zones are 
installed with the operating system. A change to the time zone adjusts the 
current time and date to match the time zone.

The clock records the time when files are created or modified on the terminal. 
You can change the time and time zone.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time Zone.

2. Press the up or down cursor to select a time zone.

Daylight Saving Time is enabled for all time zones except Japanese 
( Japan does not support Daylight Saving Time). The clock is adjusted 
automatically when Daylight Saving Time changes. 

3. Optionally, press Use Daylight Savings to enable or disable Daylight 
Saving Time for a time zone.

Changes are not permanent until you close the Time Zone dialog box.

4. Press Close when done.

5. To return to the previous dialog box, press OK.

TIP Set the time zone before you change the current date and time on the 
terminal. 
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Change the Current Date on the Terminal

To adjust the date on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Date.

2. Press Year, Month, and Day to change the current values above the 
button:
• Year is four digits in the range 1980…2099
• Month is in the range 1…12
• Day is in the range 1…31 and validated by month

3. Press OK when done.

Change the Current Time on the Terminal

To adjust the time on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time.

2. To change the current values, press Hour, Minute, and Seconds:
• Hour range is 0…23 (24-hour format)
• Minute and second range is 0…59

3. Press OK when done.
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Regional Settings You can change the display format for dates, times, and numerics to match the 
standards of a country or region. Languages are installed with the operating 
system. Before changing regional settings, you must select a language.

To select a language that is installed on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Language.

2. Select a language by pressing the up and down cursors.

3. Press OK.

The selected language shows under Current Language on the Regional 
Settings dialog box.

Change the Decimal Separator

You can change the decimal separator that is used in numeric formats for the 
selected language. The default separator is a period.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Numeric Format.

The default separator is shown.

2. Enter a maximum of three characters for the new separator.

3. Press OK.



76 Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015

Chapter 3 Configure Terminal Settings

Change the Time Format for a Language

To change the format of the time for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time Format.

The current time appears in the selected format.

2. To adjust the formats, press the appropriate selections.

The sample format changes as you make selections.

3. Press OK.

Field Description Example

Time Format
12-hour

h:mm:ss tt (default)
h = 12-hour time display, no leading zero
tt = AM or PM symbol

7:23:02 AM or 1:13:31 PM
11:43:59 AM

hh:mm:ss tt
hh = 12-hour time display with a lead zero
tt = AM or PM symbol

07:23:02 AM or 01:13:31 PM
11:43:59 PM

Time Format
24-hour

H:mm:ss
H = 24-hour time display, no leading zero

7:03:42 or 1:13:32
23:43:59

HH:mm:ss
HH = 24-hour time display with a lead zero

07:03:42 or 01:13:22
23:43:59

AM Symbol Characters to indicate AM. If the time format is set to a 
12-hour time display (h:mm:ss tt or hh:mm:ss tt), you 
can modify the AM symbol. 

AM (default)
12 character max

PM Symbol Characters to indicate PM. If the time format is set to a 
12-hour time display (h:mm:ss tt or hh:mm:ss tt), you 
can modify the PM symbol. 

PM (default)
12 character max

Separator Characters that separate fields in time format. : (default)
3 character max
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Change the Short Date Format for a Language

To change the short date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Regional Settings>Short Date Format.

2. To change the short date format, press Format.

The date updates in the Sample area as you change formats.

3. To change the character between date elements, press Separator.

The separator can be three characters. The default separator is – or /. 

4. Press OK when done.

Change the Long Date Format for a Language

To change the long date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Regional Settings>Long Date Format.

2. To change the long date format, press Format.

The date updates in the Sample area as you change formats.

3. Press OK when done.
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Notes:
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Operating System Features The PanelView™ Plus 7 terminal runs the Microsoft Windows CE version 6.0 
operating system (OS) providing the following features:

• Command shell
• Command processor
• Console window
• Windows Explorer shell
• Common dialog box
• Control panel
• Network user interface
• Soft keyboard input panels
• PDF reader
• Mouse and touch screen support with right-click support.

Topic Page

Operating System Features 79

Windows Explorer 82

Taskbar 82

Soft Input Panels 82

Windows Control Panel 83

Backup and Restore 84

Display Properties 88

Hardware Monitor 90

Logo Manager 92

User Accounts 94

Services 96

Network Server Configuration 96

System Information 109

Touch Properties 113

PDF Reader 114

TIP Touch the screen for 1 second or longer for a right-click. 
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• VNC server and client viewer

Application Support

The Windows CE operating system provides the following application 
support:

• .NET Compact Framework, version 3.5 or later
• C++ libraries and runtimes 
• Component services DCOM/COM/OLE
• Message queueing MSMQ
• MSXML, version 3.0 or later
• Microsoft foundation classes (MFC) for devices, version 9.0 or later
• Active template library (ATL)
• ActiveSync
• Cabinet (CAB) file installer/uninstaller
• ToolHelp application programming interface (API)
• Error reports (generator, transfer driver, control panel)

Scripting Support

The Windows CE operating system supports these scripting features:
• Batch/Command (BAT and CMD files)
• CS-Script
• JScript

Network Support

The Windows CE 6.0 operating system supports these network features:
• Winsock support
• Network utilities – ipconfig, ping, route
• Network driver architecture (NDIS)
• Windows networking API/Redirector
• Wired Local Area Network (LAN), 802.3, 802.5

IMPORTANT The terminal distributes two VNC client viewers:
• Vncviewer.exe is in the /Windows folder on the terminal 

desktop. To connect to, view, and control a PanelView Plus 7 
terminal, deploy this viewer to a personal computer.

• Another viewer on the terminal lets you establish a VNC 
connection to another PanelView Plus 7 terminal. To access this 
viewer, click Start>Programs>VNC Viewer.
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Server Support

Table 21 lists the servers that support the Windows CE 6.0 operating system.

Table 21 - Windows CE 6.0 Server Support

Server Default 
State Description

Web server Enabled The web server delivers content, such as web pages, by using the HTTP protocol 
over the web. 

FTP server Enabled File transfer protocol (FTP) is a standard network protocol that is used to 
exchange files over the Internet (TCP/IP-based network). 

UPnP server Enabled Universal plug and play (UPnP) is a set of networking protocols that lets devices 
install and connect to a network.

File server Enabled A network protocol that provides shared access to files, printers, serial ports, 
and miscellaneous communication between computers on a network.

VNC server Disabled Virtual network computing (VNC) is remote-control software that makes it 
possible to control another computer over a network connection. Keystrokes 
and mouse clicks are transmitted from one computer to another, over a 
network.

ViewPoint 
server

Enabled A web server application that provides remote users access via a web browser 
to the FactoryTalk® View ME HMI application that is running on the terminal. 
ViewPoint software is a Rockwell Automation® product.
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Windows Explorer From the desktop, you can access Windows Explorer in several ways:
• Double-click the My Device icon.
• Choose Start>Programs>Windows Explorer.

A few folders contain items specific to the PanelView Plus 7 Standard terminal.

Taskbar From the taskbar, you can access the Start menu, device IP information, the 
current language and time, input panels, and open programs.

To turn the taskbar on or off, choose Start>Settings>Taskbar and Start Menu, 
then clear or check the Auto Hide checkbox.

Soft Input Panels The operating system offers different input panels for entering data. You can 
access these input panels from the taskbar or the control panel. From the 
taskbar, click the input panel icon and choose the onboard keyboard that you 
want to use:

• CHT Chajei IM (Chinese)
• CHT Phonetic IM (Chinese)
• Keyboard (small keyboard)
• LargeKB (large keyboard)
• MS Kana IM ( Japanese)
• MS Roma IM ( Japanese)
• Hide Input Panel (closes the keyboard)

Folder Content

Application data Contains FactoryTalk View ME application files.
Path: \Application Data\Rockwell Software\RSViewME\Runtime

VFS (virtual file system) Contains firmware files and backup/restore files for the current system image. 
Paths: \VFS\Platform Firmware and \VFS\Backup & Restore

TIP Touch the bottom of the display to recover the taskbar when in Auto Hide 
mode.

TIP The input panel icon changes depending on which input panel you select.
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Windows Control Panel Applications in the Windows control panel let you view and configure system 
and terminal settings. For example, you can monitor hardware performance, 
calibrate the touch screen, or adjust screen saver settings.

The language of the control panel applications is based on the language set for 
the operating system. English is the default.

You can access the control panel in several ways:
• Choose Start>Settings>Control Panel.
• Open My Device on the desktop, then double-click Control Panel. 

This chapter covers control panel applications specific to the 
terminal. 

 

TIP Most terminal settings are also available in FactoryTalk View ME Station 
Configuration mode.

TIP From the View menu, you can change the size of the icons or see a brief 
description of each.

TIP Many control panel applications have scroll bars to view information on a 
smaller display, however, most examples show the full view for clarity.
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Backup and Restore The Backup and Restore application lets you copy the current system image on 
the terminal, then restore that image to the same terminal or other terminals. 
This function is useful if you want to clone a system image to multiple 
terminals. 

A typical backup includes the following:
• File system
• Firmware image
• Windows registry
• Optional user configuration data

You can include user configuration data in the backup by selecting the 
Advanced Network & Display Settings checkbox in the Backup & Restore 
dialog box.

Perform a Backup

Follow these steps to perform a backup.

1. Insert a USB drive or SD card into the appropriate slot on the terminal.

2. In the control panel, double-click the Backup & Restore icon.

3. Click browse ... on the Backup tab.

TIP You can back up a system image to a USB drive or SD card. Rockwell 
Automation recommends using a USB drive or SD card with a minimum of 
1 GB of available space. For applications with a large file system, use a 
minimum of 2 GB of available space.

Table 22 - Advanced Network and Display Settings

Setting Description

Ethernet network • DHCP-enabled or fixed IP address
• Primary and secondary DNS
• Primary and secondary WNS
• Speed and duplex settings

USB network USB IP address and subnet mask, Gateway, DHCP-enabled or fixed IP address

Network Device name

Display • Display brightness
• Screen saver dimmer timeout
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4. Select the target location for the back-up file:
• USB Storage if you are using a USB drive
• Storage Card2 if you are using an SD card

5. Type a name for the back-up file. 

Back-up files have the .pvb file type.

6. Click OK.

7. Click Backup to start the process.

A progress bar shows the status of the operation. The backup can take a 
few minutes. You receive notification when the backup completes.

8. Click OK.

If the file exists, you are asked if you want to overwrite the current file.

9. To close the Backup & Restore dialog box, click Exit.

TIP You can verify the .pvb file was successfully created when you double-click 
My Device and select the target location for the backup. If the .pvb file was 
not successfully created, use a USB drive or SD card with more available 
space. 
Rockwell Automation recommends using a USB drive or SD card with a 
minimum of 1 GB of available space. For applications with a large file 
system, use a minimum of 2 GB of available space.
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Restore a Back-up Image

Follow these steps to restore or clone a back-up image to storage device.

1. Insert the USB drive or SD card into the appropriate slot of the target 
device.

2. In the control panel, double-click Backup & Restore.

3. Click the Restore tab.

4. To select the back-up file to restore, click … (browse).

5. Select the location of the back-up file:
• USB Storage if you are using a USB drive
• StorageCard2 if you are using an SD card

6. Select the .pvb back-up file to restore.

7. Click OK.

8. Click Restore.

The restore automatically includes advanced network and display 
settings if you selected this option when performing the backup.

9. To start the restore process, click Yes.
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The terminal starts the restore process that takes a few minutes.

When the restore completes successfully, the terminal restarts.

IMPORTANT Do not remove the USB drive, SD card, or power off the terminal during a 
restore. This action can corrupt the firmware.
If the restore fails, reset the terminal from the maintenance menu.
Refer to Maintenance Mode Operations on page 143 for details.
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Display Properties Use Display Properties to control the desktop background image and 
appearance, the brightness of the backlight, and screen saver settings. 

Desktop Background

The Background tab in Display Properties controls the background bitmap on 
the desktop. The default bitmap is ‘abclocknight’.

You can select another image from the pull-down menu or browse the system 
for a bitmap image. Some custom images are in the \Windows folder.

Desktop Appearance

The Appearance tab in Display Properties controls the visual style and colors of 
the desktop and other window elements.

Two custom schemes and images provide for day or night viewing. When you 
change schemes, remember to change the image on the background tab.

Backlight Intensity

The Backlight tab in Display Properties lets you set the brightness level of the 
display between 1…100%. At 1%, the display is minimally visible.

Scheme Desktop Color Background Logo

AB Day Blue ablclockday

AB Night Black abclocknight
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Screen Saver

The screen saver extends the life of the display. When the terminal is idle for a 
continuous period, the screen saver dims the backlight and displays a moving 
image. When deactivated, the display brightness returns to its normal level.

The Screen Saver tab in Display Properties lets you perform these actions:
• Change the idle timeout for the screen saver. The default is 10 minutes.

When the screen saver activates, the dimmer controls the backlight 
intensity. You set the brightness of the dimmer in range 0…100%. The 
default intensity is 10%. At 0%, the backlight is minimally visible.

• Browse the system for another screen saver bitmap. The default screen 
saver is SSFloat.bmp. Click Add or Remove to change screen saver 
bitmap. The system recognizes bitmaps in the \Windows folder. Only 
one bitmap is supported.

• Disable the screen saver by clearing the ‘Start screen saver after’ 
checkbox.

Cursor

The Advanced tab in Display Properties lets you enable or disable the visible 
cursor that you see on the display. The cursor is visible by default.

Screen Rotation

The Advanced tab in Display Properties lets you rotate the screen on the 
terminal. The default is 0°.

After you change the screen rotation, you
have to calibrate the touch screen.
1. Plug in a USB mouse to the terminal.
2. Restart the terminal.
3. To calibrate the touch screen, use the 
mouse.
4. See Calibrate the Touch Screen on 
page 63 for calibration details.
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Hardware Monitor The Hardware Monitor provides status and troubleshooting information for 
the terminal. You can view running processes, system event log, battery 
voltages, current temperature, CPU load, and memory load.

Processes

The Processes tab in the Hardware Monitor shows all processes running on the 
terminal and memory usage of each process.

System Event Log

The System Event Log in the Hardware Monitor shows warnings, errors, and 
events that the terminal logs.

The log provides a date and time stamp of each event and text that describes the 
event. The maximum size of the log is 1 MB, approximately 4,000 records. If 
the log exceeds 1 MB, the oldest 512K of information is removed. You can 
perform the following operations on the log file:

• Press Export Log to export the log file to a CSV file (*.csv) in the 
\Windows folder. The default file name is SystemLog.csv.

• To clear all events from the log, press Clear Log.
• To view more details on a selected event, press Details.
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Monitors

The Monitors tab in the Hardware Monitor provides continuous voltage, 
temperature, and load information for the terminal.

Battery Voltage

The Monitors tab gives a visual status and voltage reading of the battery for the 
real-time clock. The battery voltage is read at power-up.

An event is logged to the system event log for a low or depleted battery.

Temperatures

The Monitors tab gives a visual status and reading of the current CPU, logic 
board, and display temperature. The temperature updates every ten minutes.

An event is logged to the system event log for a failed temperature sensor.

Table 23 - Battery Conditions

Condition Battery

Depleted Less than 2.0V indicates a dead battery or no power.

Low 2.0…2.74V

Normal 2.75V or higher

Table 24 - Temperature Conditions

Condition Temperature

Low –

Normal 25…94 °C (77…201 °F)

High 95 °C (203 °F) and higher

IMPORTANT A high temperature condition causes an automatic restart attempt. Restart 
attempts continue indefinitely until the system is cool enough to resume 
normal operation. High temperature conditions are logged to the system 
event log.
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Logo Manager Use the Logo Manager to change the logo that appears on the splash screen at 
startup and the default screen saver image. The default splash-screen image is 
the Allen-Bradley logo (ablogo.bmp).

The logo can be a .bmp, .jpg, .gif, or .png image. A 90 x 90 pixel, 16-bit color 
image provides the best results.

Before applying the new logo, you can do the following:
• Preview the logo on the splash screen.
• Resize image to fit the fixed area of the splash screen.

To apply a new logo the splash screen and the screen saver, follow these steps.

1. Double-click Logo Manager in the control panel.

The Logo Manager opens with the current logo.

2. Click Load.

3. Select the location of the new image you want to load:
• A folder on the terminal.
• Storage Card2 – SD card
• USB Storage – USB drive

4. Select the image file that you want to load.

5. Verify that the file type is correct.

6. Click OK.
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The new logo appears in the Logo Manager dialog box.

7. Check ‘Preview entire screen’ to view the logo on the splash screen.

If the logo is truncated or too small, check ‘Stretch/shrink image to fit’ 
to resize the logo to fit the area.

8. If satisfied with the preview, click Apply.

A dialog box confirms that the splash screen was updated. The default 
screen saver, ssfloat.bmp, is updated with the new image.

9. To close the Logo Manager, click OK, then click Exit.
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User Accounts User Accounts let you configure NT LAN manager (NTLM) user accounts to 
authenticate client connections when using the FTP, web, and file servers. A 
user account consists of a user name and a password. 

Follow these steps to add a user account. 

1. Double-click User Accounts in the control panel.

2. Click in the user name field and type a name.

3. To clear the field and type a password, click in the Password field.

Asterisks display as you type the password.

4. Reenter the password in the Confirm pwd field.

5. Click Add User.

6. Click OK to acknowledge the new user account.

The new user name is added to the list.

7. Repeat steps 1 through 6 to add additional user accounts.

TIP NTLM is the security protocol that provides authentication, integrity, and 
confidentiality to users on Windows operating systems. NTLM is still 
included to support Windows 2000, 2002, and 2003 server systems.
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8. When done, click X to close the dialog box.

To remove a user account, follow these steps.

1. Select a name from the user name list.

2. Click Remove User.

3. To confirm the removal of the selected user account, click Yes.

The user account list is permanently deleted from the list.

4. To close the User Account Manager, click X.

TIP Users who are entered in authentication lists of FTP, web, or file server 
configurations are removed when user accounts are deleted.



96 Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015

Chapter 4 Windows Operating System

Services The Services application shows servers the PanelView Plus 7 Standard terminal 
supports. You can enable (start) or disable (stop) each server. 

The buttons are color-coded:
• Green indicates that the server is running and automatically started at 

system startup.
• Red indicates that the server is not running.
• Gray indicates that the server is not available on the terminal.

To enable or disable a server, press the corresponding button and the color 
changes accordingly.

Network Server 
Configuration

The Network Server Configuration application configures settings for VNC, 
FTP, web, Kepware, and file server activities on an Ethernet network.

VNC Server Configuration

The terminal provides two VNC client viewers:
• Vncviewer.exe is in the /Windows folder on the terminal desktop. You 

can deploy this viewer to a personal computer to connect to, view, and 
control a PanelView Plus 7 terminal. See these sections for details:
– VNC Connection Requiring a Password for View-only Operations 

on page 97
– VNC Connection with Separate Passwords for View and Control 

Operations on page 98
• Another viewer on the terminal lets you establish a VNC connection to 

another PanelView Plus 7 terminal. To access this viewer, click 
Start>Programs>VNC Viewer. See these sections for details:
– Establish a VNC Connection Between a Local Terminal and a 

Remote Terminal on page 100
– Close a VNC Connection to a Remote Terminal on page 102
– Make a New VNC Connection to a Remote Terminal on page 102
– Transfer Files Between a Local and a Remote Terminal on page 103
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The VNC Server tab in the Network Server Configuration dialog box 
configures settings for a client device to view or control the terminal over a 
VNC connection. 

VNC Connection Requiring a Password for View-only Operations

The default VNC configuration enables view-only access to the terminal 
without requiring a password. This configuration requires the VNC viewer 
that you copy from your terminal to a computer. 

To configure a VNC connection that requires a password to view terminal 
displays, follow these steps.

1. From the control panel, click Server Config.

TIP Click OK in the title bar of the dialog box to apply new settings. You are 
asked if you want to restart the service immediately.

Table 25 - VNC Server Parameters

VNC Parameter Description Default

General

View Only (no remote 
control)

Check this option to let users view terminal displays over a VNC connection.
If you uncheck View Only, you can control and view terminal displays over a VNC connection.
If security is disabled, you are not required to enter a password when connecting to the terminal.

Enabled for view only

Security

Enable security Check this option to require password protection for VNC connections to the terminal. When checked, you must enter a 
valid password before viewing or controlling terminal displays.
If you enable security, you must supply a password for one of these parameters:
• Password - for control and view operations
• View-only password - for view only operations

Disabled (unchecked)

Password Specifies a password that you must enter when establishing a VNC connection to control terminal displays. Select the 
box, then type a password in the field at the bottom of the dialog box. The password is a maximum of seven characters.
Password protection is required to control terminal displays if:
• View Only is unchecked (allows control access)
• Security is enabled

No password

View-only password Specifies a password that you must enter when establishing a VNC connection to view terminal displays. Select the box, 
then type a password in the field at the bottom of the dialog box. The password is a maximum of seven characters.
TIP: If you uncheck the View Only parameter, you have control and view access to the terminal. With control access 
enabled, you can restrict one or more users to view-only access by providing a View-only password. 
View-only password protection is required to view terminal displays if security is enabled:
• View Only is checked or unchecked
• Security is enabled

No password

TIP Copy vncviewer.exe, in the /Windows folder on the terminal, to your 
computer and install the TightVNC software.
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2. On the VNC Server tab, check the following:
• View only (no remote control)
• Enable security

3. Select View-only password, then enter a seven-character password in the 
field that opens.

4. Click OK, then restart the server when prompted to apply new settings.

Follow these steps to launch a VNC connection to view terminal operations.

1. On your computer, choose Start>Programs>TightVNC>TightVNC 
Viewer.

2. Enter the IP address of your terminal and click Connect.

3. Enter the View-only password that is defined on the terminal and click 
OK.

The PanelView VNC Server opens the current view of the terminal on 
your desktop. You can view but not control terminal operations.

4. When finished, close the PanelView VNC Server.

VNC Connection with Separate Passwords for View and Control Operations

You can configure the VNC server to require separate passwords for view-only 
and control operations. This example uses the VNC viewer that is deployed to 
a computer to connect to the terminal.

TIP Click the network connection icon in the system tray to view the IP 
address of the terminal.

TIP Copy vncviewer.exe, in the /Windows folder on the terminal, to your 
computer and install the TightVNC software.
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Follow these steps to configure the VNC server to require a separate password 
for view-only and control operations.

1. From the control panel, click Server Config.

2. On the VNC Server tab, do the following:
• Clear View only (no remote control).
• Check Enable security.

3. Select Password, then enter a password for control privileges.

Passwords are a maximum of seven characters.

4. Select View-only password, then enter a password for view-only 
privileges.

5. Click OK, then restart the service when prompted to apply new settings.

Follow these steps to launch a VNC connection to enable control of the 
terminal.

1. On your computer, choose Start>Programs>TightVNC>TightVNC 
Viewer.

TIP To launch a VNC connection on your computer that requires a 
password for view-only operations, refer to VNC Connection 
Requiring a Password for View-only Operations on page 97 and 
follow steps 1 through 4.
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2. Click Options.

3. Clear View only (inputs ignored).

4. Click OK.

5. Enter the IP address of your terminal and click Connect.

The Standard VNC Authentication dialog box opens.

6. Enter the control password that is defined on the terminal and click OK.

7. On your computer, perform some actions to verify that you have control 
of the terminal.

8. When finished, close the PanelView VNC Server.

Establish a VNC Connection Between a Local Terminal and a Remote Terminal

Follow these steps to establish a VNC connection from a local terminal to a 
remote terminal.

TIP Click the network connection icon in the system tray to view the IP 
address of the terminal.
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1. Access the Windows desktop of the local terminal.

2. On the local terminal (viewer) desktop, choose Start>Programs>VNC 
Viewer.

3. Enter the IP address of the remote terminal that you want to connect to 
and click Connect.

A Status message displays while the connection is being made. The 
messages can cycle as the status changes.

The message ‘Please wait - initial screen loading’ can also display after 
the connection has been made and while the desktop of the remote 
terminal is loading.

After the screen has loaded, the desktop of the remote terminal displays 
on the local terminal. You can now access the features and functions of 
the remote terminal. 

TIP Select an IP address from the pull-down menu, or enter an IP 
address by using a USB keyboard or soft input panel (see Soft Input 
Panels on page 82).

The white dotted line indicates the remote terminal and is only for reference (the dotted 
line does not actually appear on the local terminal).
Note the two Start buttons: circled in white is the remote terminal; circled in black is the 
local terminal.
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Close a VNC Connection to a Remote Terminal

Follow these steps to close a VNC connection between a local terminal and a 
remote terminal.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 100).

2. On the local terminal, right-click PanelView VNC Server.
3.

4. Click Close.

The VNC connection to the remote terminal is closed.

Make a New VNC Connection to a Remote Terminal

To make a new VNC connection to another terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 100).

2. Click the New connection icon in the menu bar.

3. Enter the IP address of the new remote terminal that you want to 
connect to and click Connect.

The local terminal creates a VNC connection to the new terminal.

TIP Touch the screen for 1 second or longer for a right-click. 

TIP To toggle between the remote terminal (server) and local terminal 
(viewer) views, click PanelView VNC Server.

TIP Select an IP address from the pull-down menu, or enter an IP 
address by using a USB keyboard or soft input panel on the local 
terminal (viewer) (see Soft Input Panels on page 82).

Remote Terminal

Local Terminal
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Transfer Files Between a Local and a Remote Terminal

Use the TightVNC File Transfer dialog box to perform these tasks:
• Transfer files and folders between connected terminals
• Rename a selected file or folder
• Create a folder
• Delete a selected file or folder

To transfer files between the local terminal and the remote terminal, follow 
these steps.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 100).

2. Click the Transfer files icon in the menu bar.

3. Select the folder or files that you want to transfer.

4. Click the upload (>>)or download (<<)files icon.

5. Click Yes.

6. To view the change (if needed), click Refresh.

Download selected files from the remote 
terminal to the local terminal.

Upload selected files from the local terminal 
to the remote terminal.

Indicates the current 
directory level.

To move up one directory level, 
double-click the arrow.

Message field that records 
actions and errors for the 
current VNC session.

Rename = opens a dialog box where you can rename the selected file or folder.
Mkdir = lets you create a folder.
Remove = deletes the selected file or folder.
Refresh = updates the view.
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Web Server Configuration

The web server tab in the Network Server Configuration application 
configures settings that are used for HTTP web activities. These settings are 
standard Microsoft Windows CE parameters.

TIP To apply new settings, click OK in the title bar of the dialog box. You are 
asked if you want to restart the service immediately.

Table 26 - Web server Parameters

Parameter Description Default

Admin Users Specifies a list of users who are allowed to administer web 
activities. 
When selected, enter a list of user names, which are 
separated by semicolons, in the field that opens at the 
bottom of the dialog box.

ADMIN

Basic Authentication To require a user name and password to access the web 
server, check this option.

Disabled (unchecked)

Default Web Page Specifies default web pages that you can access. default.htm; index.htm

Allow Directory Browsing To browse directories on a web server, check this option. Disabled (unchecked)

Max Connections Specifies the maximum number of incoming web 
connections.

256

Log File Directory Specifies the path where the log file is stored. This file logs 
web activity. 

\windows\www

Max Log Size Specifies the maximum size of the log file that is stored in 
the log file directory.
A new log file is created, when the current log file reaches 
its maximum size. 

32768 bytes

NTLM Authentication To require a valid user name and password to access the 
web server, check this option.
If NTLM Authentication is enabled, you must enter a valid 
user name in the Admin Users field. 
NTLM user accounts are defined in the User Account 
Manager of the control panel.

Enabled (checked)
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FTP Server Configuration

The FTP Server tab in Network Server Configuration defines settings that are 
used to exchange files over a network. These settings are standard Microsoft 
Windows CE parameters.

The default FTP configuration lets you establish an FTP connection to the 
terminal, log in anonymously, and download files from the FTP default 
directory (\Temp).

TIP To apply new settings, click OK in the title bar of the dialog box. You are 
asked if you want to restart the service immediately.

Table 27 - FTP Server Parameters

FTP Parameters Description Default

General 

Default Directory Specifies a storage location on your terminal where you can transfer files. 
This location is the directory that users come to when they first connect to the FTP server. 

\Temp\

Idle Timeout Specifies an idle period after which inactive control connections are closed during a data transfer. An FTP session requires 
one control connection, plus one data connection, during file transfers.
Without a timeout, the FTP server process can be left pending indefinitely if the corresponding client crashes without 
closing the control connection.

300 seconds 
(5 minutes)

Debug Output Channels Specifies the number of debug output channels. 2

Debug Output Mask Specifies the port number of the output mask that is used for debugging. 23

Base Directory Specifies the path where the FTP log file and other support files are stored. \Windows

Log Size Specifies the maximum size of the file that logs FTP activities. The log file is stored in the base directory. 
A new log file is created, when the current log file reaches its maximum size. 

4096 bytes

Security Parameters

Use Authentication To require a valid NTLM user name and password to access the FTP server, check this option.
If authentication is enabled, you must enter one or more valid user names in the User List field. 
NTLM user accounts are defined in the User Account Manager of the control panel.

Enabled (checked)

Allow Anonymous Logins To let anyone connect to the FTP server, check this option. Anonymous logins do not require a user name and password. Enabled (checked)

Allow Anonymous Uploads To let users logged in anonymously to upload (or write) files to the FTP server (or default directory), check this option.
If unchecked, users logged in anonymously can download (or copy) files from the server.

Disabled (unchecked)

Allow Anonymous VRoots To let users logged in anonymously to access virtual roots, check this option. Disabled (unchecked)

User List Specifies the NTLM users that can access the FTP server and exchange files to or from the default directory.
When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at 
the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.

None
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FTP Anonymous Login and Upload

Use the default FTP security options to log in anonymously to the terminal 
and copy files between your computer and the default FTP folder on the 
terminal.

To establish an FTP connection to the terminal by using anonymous logins 
and file transfers to and from the FTP folder, follow these steps.

1. On your computer, open the web browser or any folder.

2. Determine the IP address of your terminal by clicking the Network 
Connection icon in the system tray.

3. Type the terminal IP address in the address field. 

A connection is established to the \Temp folder, the default FTP 
directory on the terminal. The terminal shows two files.

If you launch the FTP connection from your web browser, this view can appear.

To see the folder view, choose Open FTP site in Windows Explorer from the 
Page pull-down menu.

TIP If Allow Anonymous Uploads is unchecked, you can copy files from the 
default FTP folder on the terminal but not to the folder.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96
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4. Transfer files between your computer and the FTP folder on the 
terminal:
• Drag or copy a file from the FTP folder to your computer.
• Drag or copy a file to the FTP folder from your computer.

FTP Connection Requiring User Authentication

You can require a user name and password before establishing an FTP 
connection. On the FTP Server tab, check Use Authentication. Select User 
List and enter a valid user name in the field that opens at the bottom of tab.

To establish an FTP connection to the terminal by entering a valid user name 
and password, follow these steps.

1. On your computer, open any folder or the browser.

2. Determine the IP address of your terminal by clicking the Network 
Connection icon in the system tray.

3. Type the terminal IP address in the Windows Explorer address field.

4. Click OK if the FTP Folder Error dialog box appears.

5. From the File menu, choose Login As.

TIP User names and passwords are configured in the User Accounts 
application of the control panel. Refer to User Accounts on page 94 for 
details.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.
For example, ftp://192.168.124.96

TIP The user name must be in the User List of the FTP configuration 
and previously configure as a valid account in the User Accounts 
application. 
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6. Type a valid user name and password, then click Log On. 

The default FTP directory on the terminal opens. You can transfer files 
to or from this folder.

File Server

The File Server tab in Network Server Configuration has settings that allow 
shared access to files, printers, serial ports, and miscellaneous communication 
between computers on a network. These settings are standard Microsoft 
Windows CE parameters.

TIP To apply the new settings, click OK in the title bar of the dialog box. You are 
asked if you want to restart the service immediately.

Table 28 - File Server Configuration

Parameter Description Default

General

Adapter List Provides a list of valid adapters. * (all adapters)

Max Printer Swap Size Specifies the maximum size of the printer swap file. 4096 bytes

Security Options

Use Authentication To require a valid NTLM user name and password to access 
the file server, check this option.
If authentication is enabled, you must enter one or more 
valid user names in the User List field. 
NTLM user accounts are defined in the User Account 
Manager of the control panel.

Disabled (unchecked)

User List Specifies a list of valid NTLM users who are allowed to 
access the file server. 
When selected, you can enter a list of NTLM user names, 
which are separated by semicolons, in the field that opens 
at the bottom of the dialog box. User names and 
passwords are defined in the User Account Manager of the 
control panel.

None
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KEPServer Configuration

The Kepware Server tab in Network Server Configuration lets you select 
Kepware communication drivers for connected devices.

System Information The System Information application provides tabs to view and set system-wide 
properties for your terminal.

General Information

The General tab of System Information shows the current version of the 
Windows CE operating system, the processor type, speed, and available 
memory.

Startup Options

The Startup Options tab of System Information lets you set these start-up 
options:

• Show or hide the battery warning
• Launch the terminal as open or closed
• Disable or enable Safe mode

TIP For a complete list of KepWare drivers, go to
http://www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘KepWare Drivers for PanelView Plus’.

IMPORTANT To apply new settings, click OK in the title bar. You are asked if you want to 
restart the service immediately. You must also reset your terminal.
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• Configure the Ethernet ports for DLR, star, or linear topology
• Show or hide system watchdog errors

Battery Warnings

If the battery is low, missing, or depleted, a 
warning appears each time that the terminal 
starts up.

You have three options for handling the battery.

Startup Options

To launch an open or closed desktop at startup and to set the visual appearance 
of button controls, use the Shell options.

TIP • The terminal can operate 
without a battery if the accuracy 
of the date and time is not 
critical. 

• When replacing the battery, you 
can verify the accuracy of the 
system date and time from the 
desktop control panel or the 
terminal settings in FactoryTalk 
View ME Station.

Battery Warning Startup Options Description

Always show at startup (continue with startup) Shows the battery warning at startup with FactoryTalk View 
ME Station software that runs behind it. This option is the 
default.

Always show at startup (halt startup) Shows the battery warning at startup but halts the startup or 
boot process until you press OK. 

Never show at startup Hides the battery warning at startup.
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Boot Option

The boot options provide a way for you to enter Safe mode at startup.

Configure the Ethernet Ports

The ‘Network (On-board Embedded Ethernet Switch - DLR)’ provides 
options to configure the onboard Ethernet switch of the terminal for the 
network topology. You can also configure the Ethernet ports from the terminal 
menus. See Configure the Ethernet Ports on page 56.

After changing the selections, restart the terminal for the changes to take effect.

Shell Startup Options Description

Type Launches the terminal as an open or closed system at startup:
• (Open system) – launches the Windows CE desktop on startup.
• (Closed system) (default) – launches FactoryTalk View ME Station 

Configuration mode on startup.
You can also allow or restrict desktop access within FactoryTalk View ME 
Station Configuration mode by pressing Terminal Settings>Desktop 
Access Setup. Refer to Desktop Access on page 46.

User Interface Button Controls Sets the visual appearance of control buttons at startup:
• Windows XP Style (default)
• Windows 95 Style

Safe Mode Options Description

Do not detect Safe mode request at 
startup

Disables Safe mode detection during startup. This option is the default.

Detect Safe mode request at startup Displays a small white box in the lower left corner of the terminal display 
during startup. To enter Safe mode, press and hold the white box. This 
option lets you bypass a loaded FactoryTalk View ME application and go 
directly to Configuration mode. If you do not press the white box, the 
system boots up normally.
Another way to enter Safe mode is to access Maintenance mode. 
See Maintenance Mode Operations on page 143.
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Watchdog Errors

You can show or hide watchdog errors at startup.

Advanced Diagnostics

Advanced diagnostics are for technical support use to diagnose and resolve 
system errors. They are not for use in a normal production environment.

Device Name

The Device Name tab of System Information identifies your terminal to other 
devices on the network by providing a device name and description.

Port (Link) Configuration Description

Port 1 (Link 1) and Port 2 (Link 2) Enabled Enables Link 1 and Link 2 Ethernet connections for DLR 
configuration.

Port 1 (Link 1) Only Enabled Enables Link 1 Ethernet connection for star or linear configuration.

Port 2 (Link 2) Only Enabled Enables Link 2 Ethernet

Watchdog Error Options Description

Always show watchdog errors at startup Shows the fatal watchdog error (error 02) at startup and halts 
the normal boot process. This option is the default.
The system launches the maintenance window with the 
watchdog error displayed. You can continue booting from this 
window. Refer to Maintenance Mode Operations on page 143 
for details.
The error is logged to the System Event log.

Never show watchdog errors at startup Hides the errors at startup and adds the error to the system 
event log.
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Touch Properties Touch Properties is accessible on devices with a touch screen. It lets you 
calibrate the touch screen and set the sensitivity of touch screen taps.

Calibration

If your device is not responding appropriately to taps, the Calibration tab lets 
you recalibrate the touch screen. To recalibrate, follow the instructions in the 
dialog box.

Double-Tap

The Double-Tap tab lets you set and test the double-tap sensitivity of the touch 
screen taps.

TIP Device names must be unique. Duplicate names conflict and cause 
network problems.



114 Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015

Chapter 4 Windows Operating System

PDF Reader The PDF reader provides typical view and search functions. You can run this 
reader from the Windows desktop or a command prompt.

When viewing a PDF document, you can initiate functions from the menu or 
toolbar. Bookmarks created in the original PDF appear under bookmarks.

Figure 8 - PDF Reader Workspace

Some viewing functions can be initiated on touch screen terminals with a 
touch or drag.

3/32

Page 
Navigation

Zoom 
Rotate

Search
Bookmarks

Page Navigation
Open

Current Page 

Magnified view of page with minimap. You can 
touch the gray areas on the minimap to view 
another area of page at the same zoom level.

Prev/Next

Table 29 - Touch Screen Operations 

To Do This Indicator

Zoom In or Out Tap the screen once to zoom in.
Tap the screen again to zoom out.
If Menu>View>Minimap is chosen, a miniview of the page appears in lower right of 
workspace. You can tap the gray areas to change view.

Navigate pages • Drag your stylus or finger to the right or left to view next and previous pages.
An indicator shows the direction your are dragging.
A box shows the current page/total page count.

• To activate the page navigation bar on the right, drag up or down the screen.
Move slide bar up or down to navigate pages.

See page 
navigation bar in 
Figure 8.

Rotate Drag in a circular, clockwise or counterclockwise direction to rotate the page.

3/32
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Command Prompt Parameters

You can run the PDF reader from the Windows Command Prompt when you 
choose Start>Programs>Command Prompt and execute the command 
parameters in Table 30.

Command Prompt Syntax

Foxitreader “file_path/file-name.pdf ” parameter parameter_ value
• To separate the file path directories and file name, enclose the file 

path and file name in double quotes and use forward slashes.
• To separate the parameter from the file name and optional parameter 

value, use spaces.

Command Prompt Example

Foxitreader “windows/desktop/example.pdf ” -p 4.

This command prompt opens example.pdf in Foxit Reader at page 4.
Table 30 - Command Prompt Parameters

Parameter Parameter Function Example Description

-p Go to page Foxitreader “file_path/file.pdf” -p 2 Opens the PDF file to page 2.

-zw Fit width Foxitreader “file_path/file.pdf” -zw Opens the PDF file and fits the view to the page width.

-zp Fit page Foxitreader “file.pdf”-zp Opens the PDF file and shows the full page.

-z Zoom to Foxitreader “file.pdf”-z 150 Opens the PDF file and zooms to 150%.

Multiple 
parameters

Enter empty spaces between 
parameters and parameter values

Foxitreader “file_path/file.pdf” -p 2 -zw Opens the PDF file to page 2 and fits the view to the 
page width.

-b Go to bookmark Foxitreader “file_path/file.pdf” -b “Bookmark1” Opens the PDF file to the location specified within 
Bookmark1.

-d Go to named destination Foxitreader “file_path/file.pdf” -b “Destination1” Opens the PDF file to the location specified within 
Destination 1.

-g Disable the File>Open command on 
the Menu and the Open folder button.

Foxitreader “file_path/file.pdf” -g Opens the PDF file and dims the Menu, File>Open 
command and the Open button.
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Notes:
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ATTENTION: Prevent Electrostatic Discharge (ESD)
This equipment is sensitive to electrostatic discharge that can cause internal 
damage and affect normal operation.
Follow these guidelines when you handle this equipment:
• Touch a grounded object to discharge potential static.
• Wear an approved grounding wriststrap.
• Do not touch connectors or pins on component boards.
• Do not touch circuit components inside the equipment.
• Use a static-safe workstation, if available.
• Store the equipment in appropriate static-safe packaging when not in use.

ATTENTION: Shock Hazard
Disconnect all power before installing or replacing any components. Failure to 
disconnect power can result in electrical shock or damage to the terminal. 

At the end of its life, collect this equipment separately from any unsorted 
municipal waste.

TIP For a complete list of supported devices, go to
http://www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘PanelView™ Plus Hardware Compatibility 
List’.
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Connect to USB Ports Each terminal has one USB 2.0 (type A) host connection and one USB 2.0 
(type B) device connection:

• The USB host connection supports removable USB drives and a USB 
printer. 

• The USB device connection supports a connection to a host computer.

Icons identify the USB host connections. The USB host connection supports 
0.5A at 5V DC. Connected USB devices must not exceed this power load.

IMPORTANT  Refer to Required Circuit Port Parameters for USB Peripheral 
Devices on page 24 for information on how to use the USB host 
ports and USB peripheral devices in hazardous locations.

IMPORTANT The USB host and device connections are intended for temporary use. Do 
not use the USB host and device connections for runtime operations. 

Table 31 - USB Connector Pinout

USB Port Icon USB Connector Pin Signal Description

Host 1 VCC +5V

2 D- Data -

Device 3 D+ Data +

4 GND Ground

WARNING: USB devices that are not powered by the USB port must be 
within the same enclosure as the terminal. The USB devices must be 
connected to a ground system common with the terminal or used with a 
USB hub that provides galvanic isolation. 

USB Host Connection

USB Device 
Connection



Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015 119

Install and Replace Components Chapter 5

Connect only externally powered USB hubs to the terminal that are USB 2.0 
compatible. Before you attach devices to a USB hub, make sure that the power 
adapter is connected and powered on. 

USB Cables

Use high-speed, USB 2.0 certified cables for error-free transmissions.

Install a USB Printer The terminal supports the connection of one USB printer such as Canon, 
Epson, Hewlett-Packard, and Brother. The printers support plug-and-play 
installation and manual installation if a suitable driver is available. You can 
connect a printer to a USB port on the terminal.

Printers are configured and managed from the Printers application  in the 
desktop control panel. A wizard is supported for each printer type.

After configuring a printer, you can access it from desktop applications or from 
FactoryTalk® View ME Station. Press Terminal Settings, then choose Print 
Setup. Applications can also select and share printers.

Plug-and-Play Installation

Follow these steps to install a plug-and-play printer from the Windows 
desktop. For manual printer installation, refer to Manual Printer Installation 
on page 121.

1. Connect the printer to a USB host port on the terminal.

2. Plug the power cord of the printer into an outlet and turn on the printer.

TIP For more information on supported printers, go to
http://www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘Printers Supported on PanelView Plus’.

Table 32 - Support for Printers

Printer Type Description

Local USB You can connect a JETCET-supported printer to a USB host port.
The printer that is attached to the USB host port can be shared by a remote terminal when 
configured as a network printer on the remote terminal.

Network The terminal supports a remote printer that is connected to the network via the Ethernet 
port. The printer address can be its device name or IP address.

RDP /ICA A local printer can be made available to a Windows server application that is running in a 
remote desktop protocol (RDP) session on the terminal.

TIP This procedure shows a plug-and-play installation for the Hewlett Packard 
HP deskjet 5650 printer.
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Windows automatically detects your plug-and-play printer, and in most 
cases, without requiring you to make any selections.

The printer is ready to print.

3. Verify printer installation from the desktop control panel by opening the 

Printers  application. 

Notice the icon for the Deskjet 5650C printer. The check mark 
indicates that this printer is the default printer.

4. From the File menu, choose Properties to view the properties of the 
printer.

Printer properties include the printer name, manufacturer and model, 
print driver, and port-specific parameters.

5. To verify the installation, right-click the printer and print a test page.

When printing from an application such as WordPad, a Print dialog box opens 
where you can adjust settings.

IMPORTANT If automatic plug-and-play installation is not supported for a printer, the 
error is logged to the System Event log in the Hardware Monitor.
For example: JETCET PRINT was unable to auto-configure printer. To 
configure the printer manually, go to the Printers folder from the Control 
Panel.

TIP • New printer configurations are retained through a power cycle.
• Printers that are configured through the desktop control panel are also 

available within FactoryTalk View ME Station when pressing Terminal 
Settings>Print Setup.
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Manual Printer Installation

Follow these steps to install a supported printer manually.

1. Connect the printer to a USB port of the terminal.

2. Plug the power cord of the printer into an outlet and turn on the printer.

3. From the desktop control panel, open Printers  .

4. Click Add Local Printer.

5. Follow the Add Local Printer Wizard instructions to configure the 
printer:
a. Verify that the connected printer appears on the USB printer port.
b. Select the manufacture and model of the JETCET printer.
c. Accept the default printer name or enter another.
d. To verify the installed printer, print a test page.
e. Specify whether you want the printer to be shared on the network.

Insert an SD Card An SD card provides extra storage when inserted into the SD card slot of the 
terminal. Supported cards include catalog numbers 1784-SD1 and 1784-SD2. 
The SD cards are hot-swappable; they can be inserted and removed while the 
terminal is powered on and in operation. 

WARNING: EXPLOSION HAZARD
If you remove or insert an SD card while the power is on, an electric arc can 
occur. This action can cause an explosion in hazardous location installations.
Do not remove and insert the SD card unless power has been removed or the 
area is known to be nonhazardous.
For ATEX and hazardous location installations, the SD card cover must be 
installed.
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The SD card slot is accessible from the inside or back of the panel when the 
operator terminal is installed. 

Follow these steps to install an SD card in the card slot.

1. Remove the protective cover from the card slot.

2. Verify that the SD card is locked or unlocked according to your 
preference. 
• If unlocked, the terminal can write data to or read data from the card.
• If locked, the terminal can only read data from the card.

3. Insert the SD card firmly into the slot.

To remove the card, grasp the end of the card and pull it out.

4. Attach the protective cover over the card slot (the protective cover is 
shipped with the terminal).

ATTENTION:  Orient the SD card correctly before inserting into slot. 
If you force the card into the slot, you can damage the card or the 
terminal.

Unlocked
Locked
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Replace the Battery The product has a lithium battery that provides backup power for the real-time 
clock and static RAM. The battery can be replaced while the product is 
mounted in the panel. No special tools are required to replace the battery.

Perchlorate material – special handling may apply. See www.dtsc.ca.gov/
hazardouswaste/perchlorate.

This perchlorate warning only applies to primary Lithium Manganese Dioxide 
(LiMnO2) cells or batteries, and products containing these cells or batteries, 
sold or distributed in California, USA.

Follow these steps to replace the battery.

1. Disconnect power from the terminal.

2. Remove the battery cover by rotating it from the C (closed) to the O 
(open) position.

ATTENTION: The cover is required to secure the card in high-shock 
and vibration environments. It also prevents ESD discharge to the 
card during runtime operation.

This product contains a sealed lithium battery, which may need to be replaced 
during the life of the product.
At the end of its life, the battery contained in this product should be collected 
separately from any unsorted municipal waste.
The collection and recycling of batteries helps protect the environment and 
contributes to the conservation of natural resources as valuable materials are 
recovered.

WARNING:  There is a danger of explosion if the lithium battery or real-
time clock module in this product is incorrectly replaced. Do not replace the 
battery or real-time clock module unless power has been removed and the 
area is known to be nonhazardous. 
Replace the battery only with catalog number 2711P-RY2032 or an equivalent 
CR2032 coin-cell battery.
Do not dispose of the lithium battery or real-time clock module in a fire or 
incinerator. Dispose of used batteries in accordance with local regulations.
For safety information on the handling of lithium batteries, including handling 
and disposal of leaking batteries, see Guidelines for Handling Lithium 
Batteries, publication AG 5-4.
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3. To disengage the battery, on the metal latch, press the vertical center tab 
away from the battery.

The battery is released.

4. Insert the new battery at an angle under the metal latch, with the 
positive polarity (+) up.

5. Gently press down on the opposite side of the battery until it locks into 
place.

6. Replace the battery and rotate the cover from the O (open) to the C 
(closed) position.

IMPORTANT Make sure that the battery is fully inserted under the plastic tabs. If the 
battery is not fully inserted, the terminal can be damaged.
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Install a Protective Overlay The overlay protects the terminal touch screen from scratches, dust, 
fingerprints, and external damage from chemicals or abrasive materials. See 
Table 4 on page 17 for a list of available protective overlays.

The protective overlay covers the entire 
surface of the terminal bezel inside the plastic 
perimeter. The overlay has a protective liner 
that is removed by pulling back on the tab. Do 
not remove the liner until you are ready to 
install the overlay. 

Before installing the overlay, use a lint-free cloth and a mild glass cleaner to 
clean the touch screen surface. Remove all fingerprints, grease, or dust. Marks 
not removed are trapped underneath the overlay. Grease also affects the 
adhesion of the overlay.

To apply the protective overlay, follow these steps.

1. Disconnect power from the terminal.

2. Pull the tab from one of the short sides and partially peel the liner away 
from the adhesive layer.

IMPORTANT Follow these precautions when installing the protective overlay:
• Make sure that your hands are clean and dry.
• Handle the overlay by its edges. If you get marks or lint on the overlay, 

remove them before proceeding. 
• Do not touch the adhesive ring.

Tab

Adhesive Ring

Protective liner
(covers adhesive)
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Hold the peeled back portion of the protective liner out of the way as 
you perform the next step.

3. Center the overlay over the bezel and carefully position the adhesive 
surface on the terminal.
While the protective liner is still covering the rest of the overlay, verify 
that it is properly centered.

4. To press the overlay on the screen, slowly peel off the rest of the liner 
while using a soft cloth.

Make sure that the overlay lies flat with no bubbles or warps.

5. With a soft cloth or finger, press around the edges of the overlay to seal 
it, and remove any air bubbles trapped in the adhesive.

Clean the Overlay

To clean the overlay, use a clean, lint-free cloth, and a mild glass cleaner that 
leaves no streaks. Windex or an eye glass cleaner is recommended. Do not use 
cleaners that contain abrasives.

Remove the Overlay

Remove the overlay if it is damaged or needs replacement. Lift a corner and 
slowly pull off the overlay. To remove any residual adhesive, use isopropyl 
alcohol. Do not reuse the overlay.

Overlay

Bezel

Protective Liner
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Terminal Firmware Firmware components are packaged as execute-in-place (XIP) regions in one 
system code (SC) .img file. When the SC .img file is copied to the virtual file 
system (VFS) on the terminal, the XIP regions are updated and the terminal 
restarts automatically. These firmware components are affected during an 
upgrade:

• FactoryTalk® View ME Station software
• Communication protocols and drivers including Kepware drivers
• Windows fonts
• Windows CE components
• FactoryTalk components
• User extensions

A firmware update does not affect these terminal components or settings: 
• Windows registry
• File system including the FactoryTalk View ME application that is 

loaded(1) in the terminal
• Network parameters including the network device name, DHCP-

enabled and static(2) IP addresses, speed, and duplex setting
• Display settings
• Screen saver configuration
• Touch screen calibration

Topic Page

Terminal Firmware 127

Download Firmware Files 128

Firmware Upgrade Wizard 129

Upgrade the Terminal Firmware from a Storage Device 129

Upgrade Terminal Firmware over the Network 133

(1) In some cases, the FactoryTalk View ME application can be missing after a firmware update.
(2) In some cases, static IP addresses have been changed to DHCP-enabled IP address after a firmware update.



128 Rockwell Automation Publication 2711P-UM007D-EN-P - December 2015

Chapter 6 Update Firmware

Download Firmware Files Download the appropriate firmware installation package from the Rockwell 
Automation Product Compatibility and Download Center. The package is 
named:

PVP7_<terminal family>_x.xx-yyyymmdd.exe, where:

• <terminal family> is the name of the terminals
• x.xx is the FactoryTalk View ME software version that is contained in 

the package
• yyyymmdd is the date that the package was created

This installation package contains the following items:
• Firmware upgrade package (FUP) contains an autorun executable and 

the new firmware files.
• Firmware upgrade wizard (FUW), version 6.10 or later, is used to 

upgrade the terminal firmware by using the contents of the FUP.

The FUP and FUW are copied to your computer during the download. 

Follow these steps to download firmware installation files to your computer.

1. From the Quick Links list on http://www.ab.com, choose Product 
Compatibility and Download Center.

2. Click the Get Downloads tab.

3. Click Find Product Downloads.

4. From the All Families pull-down menu, choose PanelView Plus 7.

5. Select a firmware version, then click Downloads.

6. Download  the upgrade file (.exe) to a temporary folder on the 

same drive as FactoryTalk View ME (ME) software.

7. Run the upgrade file (.exe) installation procedure: 
• The FUW is installed in the FactoryTalk View ME folder. 
• The firmware upgrade package (.FUP) file is installed into the folder 

that is specified during the installation procedure.

You are now ready to run the FUW to upgrade the terminal firmware from a 
USB drive or SD card, or by using a network connection.

TIP The FUP name is ME_PVP7xA_6=7.xx-yymmdd
• yyyymmdd is the date the firmware package was created
• 7.xx is the version of ME contained in this package 
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Firmware Upgrade Wizard The firmware upgrade wizard (FUW) is used to upgrade the terminal 
firmware. Two methods are provided for upgrading the firmware:

• Create a firmware upgrade card with the contents of the FUP file that 
you can then load in the terminal to upgrade the firmware. 

The firmware upgrade card can be a USB drive or an SD card, catalog 
number 1784-SDx.

• Upgrade firmware in a terminal that is connected to a computer over a 
direct network connection. The network connection requires a 
computer running RSLinx® Enterprise software, version 5.0 or later. In 
the RSLinx Enterprise software, you select the terminal that you want to 
upgrade.

You can run the FUW from within FactoryTalk View Studio software or from 
the Programs menu on your computer:

• In FactoryTalk View Studio software, from the Tools menu, choose 
Firmware Upgrade Wizard.

• Choose Start>Programs>Rockwell Software>FactoryTalk 
View>Tools>ME Firmware Upgrade Wizard.

Upgrade the Terminal 
Firmware from a Storage 
Device

To upgrade firmware from a storage device, you follow a two-step process. 
First, you create a firmware upgrade card with the required firmware files. 
Second, you load the card in the target terminal to upgrade the firmware.

The firmware upgrade card can be a USB drive or an SD card.

Create a Firmware Upgrade Card

Follow these steps to copy firmware files to a USB drive or SD card.

1. Insert either a USB drive or an SD card into the appropriate slot on your 
computer.

2. Run the Firmware Upgrade Wizard:
• In FactoryTalk View Studio software, from the Tools menu, choose 

Firmware Upgrade Wizard.
• Choose Start>Programs>Rockwell Software>FactoryTalk 

View>Tools>ME Firmware Upgrade Wizard.

3. Follow these steps from the initial Firmware Upgrade Wizard dialog 
box.
a. Click Create firmware upgrade card.
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b. Select the location of the firmware card by browsing to the root 
directory of the storage card that is loaded in your computer for 
example E:\.
The firmware files are copied to this location. You can also specify a 
folder on the hard disk.

c. From the Existing terminal type pull-down menu, select a PanelView 
Plus 7 terminal.

d. Click Next.

4. Follow these steps from this dialog box.
a. Browse to the location of the firmware source files on your computer, 

where the FUP was installed. 

b. Choose the firmware version for the upgrade.
c. Click Next.

It can take several seconds for the next dialog box to appear while the 
FUP is being retrieved.

5. From this dialog box, optionally select the KEPServer drivers that you 
want included with the firmware, then click Next.
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Kepware drivers are already installed on the PanelView Plus 7 Standard 
terminals.

The final dialog box summarizes your choices for creating the firmware 
upgrade card.

6. Click Finish to copy the firmware files to the firmware upgrade card.

A progress bar automatically updates as files are copied to the USB drive 
or SD card. 

7. Click OK when the firmware upgrade completes successfully. 

8. Remove the USB drive or SD card from your computer.

9. To use this firmware upgrade card to upgrade the terminal firmware, go 
to the next section.

TIP If the firmware files were copied to the hard disk, copy the files to the 
root directory of the USB drive or SD card.
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Upgrade Terminal Firmware by Using a Firmware Upgrade Card

Follow these steps to transfer firmware files from the USB drive or SD card to 
the terminal. Use the firmware upgrade drive or card that you created in the 
previous section.

1. Insert the USB drive or SD card into the appropriate slot on your 
terminal. 

The firmware upgrade automatically starts and displays this dialog box.

2. Press Upgrade or [F7] on the terminal to start the firmware upgrade.

The terminal restarts and displays a progress bar during the upgrade. 

When the upgrade is complete, the terminal restarts and executes the 
new firmware.

3. Remove the USB drive or SD card from the terminal.

IMPORTANT • Do not remove or disconnect the USB drive or SD card while a firmware 
upgrade is in process. If you do, you can corrupt the firmware and make 
the terminal unstable.

• Do not power off the terminal during a firmware upgrade.
• USB hubs can produce unexpected behavior and are not recommended. 

IMPORTANT If the firmware upgrade fails because of a power loss or the firmware 
upgrade card is inadvertently removed, you can restore the terminal to the 
factory default firmware. See Maintenance Mode Operations on page 143 
for details on how to restore the factory default settings.
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Upgrade Terminal Firmware 
over the Network

You can upgrade firmware in a terminal that is connected to a computer over a 
direct network connection. The network connection requires a computer that 
is running the firmware upgrade wizard (FUW) and RSLinx Enterprise 
software, version 5.0 or later.

RSLinx Enterprise software is required so that you can select the terminal on 
the network.

Follow these steps to copy firmware files to the terminal over a network by 
using RSLinx Enterprise software and Ethernet communication.

1. Run the Firmware Upgrade Wizard:
• In FactoryTalk View Studio software, from the Tools menu, choose 

Firmware Upgrade Wizard.
• Choose Start>Programs>Rockwell Software>FactoryTalk 

View>Tools>ME Firmware Upgrade Wizard. 

2. Click ‘Upgrade firmware on terminal’ and click Next.

3. To continue, click Yes.

It is not necessary to back up files on PanelView Plus 7 Standard 
terminals.
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4. Click ‘Network connection (using RSLinx Enterprise)’ and click Next.

This option is the only valid selection for PanelView Plus 7 Standard 
terminals.

5. To receive the firmware update, select the terminal and click Next.
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6. Follow these steps from this dialog box.
.

a. Browse to the location of the firmware source files on your computer, 
where the FUP was installed.
The default location is shown.

b. Choose the version of the upgrade firmware from the pull-down 
menu.

c. Click Next.
It can take several seconds for the next dialog box to appear while the 
FUP is being retrieved.

7. From this dialog box, optionally select the KEPServer drivers that you 
want included in the firmware, then click Next.

Kepware drivers are already installed on the PanelView Plus 7 Standard 
terminals.
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The final dialog box summarizes your choices for upgrading the terminal 
firmware.

8. Click Finish to update the firmware in the terminal. 

9. To continue with the update, click Yes.

A progress bar updates as firmware files are copied to the terminal.

10. Click OK when the firmware upgrade is complete.

The terminal restarts and executes the new firmware.

IMPORTANT If the firmware upgrade fails because of a power loss or the firmware 
upgrade card is inadvertently removed, you can restore the terminal to the 
factory default firmware. See Maintenance Mode Operations on page 143 
for details on how to restore the factory default settings.
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View System Information View system information for the terminal from FactoryTalk® View ME Station 
runtime or from the Hardware Monitor in the control panel.

Follow these steps to view system information for the installed components.

1. Access FactoryTalk View ME Station runtime.

2. Tap Terminal Settings, then choose System Information>About 
FactoryTalk View ME Station.
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Status Indicators The back of the terminal has two indicators to identify system status:
• STS indicator (green) indicates that the terminal is on and running
• ERR indicator (red) indicates hardware and firmware faults

At startup, the STS and ERR indicators flash on and off, then the STS 
indicator flashes to signal progress during startup. If the indicators remain off, 
check the power cable.

After a successful startup, the STS indicator remains on.

The table shows indicator states if the terminal stops during startup.

Terminal Does Not Start Up If the terminal does not start up normally, check the table for possible causes.

Table 33 - Fault Indicator States During Terminal Startup

ERR (red) STS (green) Description Recommended Action

Blinking Off

Recoverable firmware error. Reload the firmware.

Recoverable configuration failure. Restore the terminal to its factory 
default image. Refer to Restore a Back-
up Image on page 86.

On
On Fatal hardware error. Replace the terminal.

Blinking Fatal display hardware error. Replace the terminal.

S
T
S

E
R
R

Table 34 - Terminal Does Not Start Up Properly

Check For What to Do See This Page

Insufficient power Make sure that the device is receiving adequate power.
• Check the DC power requirements.

 
page 35

Improper power wiring Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.

page 34
page 35

Status indicators Check the status indicators during startup. page 138

Stalled progress 
indicator

If a terminal stalls at the progress indicator and does not load an 
application or configuration screens, reload the firmware or restore 
factory defaults.

page 86

Object that is touching 
the display

Verify that nothing is pressing against the display or that you are not 
touching the display during startup.

N/A
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Terminal Restarts 
Intermittently

If the terminal restarts intermittently, check the table for possible causes.

Touch Screen Issues If the touch screen is not responding correctly to touches with a finger or 
stylus, check the table.

Table 35 - Terminal Restarts Intermittently

Check For What to Do See This Page

Improper power 
wiring

Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.

page 34
page 35

Over-temperature 
conditions

Make sure that the processor is not exceeding temperatures for 
normal terminal operations.
• Check the processor temperature.
• Check the System Event log for over-temperature conditions.
• Check for adequate clearances around the terminal in the panel.
• Check for proper operating temperature.

page 91
page 69 or page 90
page 25
page 91

Table 36 - Touch Screen Not Responding

Check For What to Do See This Page

Improper calibration Check for activation points that are offset from touch points.
Calibrate the touch screen.

page 63 or 
page 113

Non-functioning 
touch screen

Check the touch screen for damage, such as cuts or excessive wear. 
If there is damage, replace the terminal.

N/A

Touching multiple 
input elements

Application screens contain graphic input elements that are 
configured in the Machine Edition application. When touched, 
these elements perform operations in a predictable manner. For 
example, an input element is configured to navigate to a specific 
screen in the application or start a motor when touched.
Multiple operations cannot be conducted simultaneously. Doing so 
results in an unintended operation.
• Do not touch multiple input element simultaneously. 
• Do not rest a hand or multiple finger on the display.

N/A
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Display Issues The display is unreadable or dims unexpectedly.

ATTENTION: If the display darkens, or if the backlight is not functioning 
properly, the screen can be difficult to read and use of this touch screen 
could result in a potentially hazardous outcome. Do not use the touch 
screen under these circumstances. The design of the system must take 
into account the possibility of the touch screen losing functionality and 
unable to be used to maintain or change control of the system. The touch 
screen shall not be the single point of control of critical functions and is not 
intended to replace an E-stop.
Design of the system should follow all applicable code and good engineering 
practice. Factors to consider include:
• The possibility of an unreadable touch screen
• The possibility of an inoperable touch screen
• Unexpected communication errors or delays
• Operator error in the control of the system
• Proper use of E-stops and other safety practices
The user shall provide means to achieve a safe state during anomalies and 
make sure the system has adequate redundancy for critical functions.
Failure to follow these instructions can result in death, serious injury, 
or equipment damage.

Table 37 - Dim Display

Check For See These Pages

Low display brightness setting page 61 or page 88

Low brightness level of screen saver page 62 or page 89

Temperatures outside the operating range page 70 or page 91

TIP Extend the life of the backlight by reducing the display brightness, by using 
the screen saver with reduced brightness, or operating at lower 
temperatures.
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Ethernet Issues See Figure 38 on page 141 for tips on how to isolate Ethernet anomalies.

Performance Is Slow If the response time of the application is slow, for example screen changes or 
text display changes, check for the following issues:

• Application screens contain too many elements.
• If the controller is programmed for feedback, it can cause delays.
• Slow network performance or noise can result in retries.

Resistance to Chemicals The outer surfaces of the terminal including the bezel, touch screen overlay, 
and panel sealing gasket are tested for chemical resistance. Some of the 
chemicals can cause discoloration, but they do not interfere with the operation 
of the terminal. 

Table 38 - Ethernet Connection Issues

Check for These Issues What to Do

Status of invalid Ethernet connection • Green indicator is on when a link is established.
• Yellow indicator blinks when activity is detected.
• Verify network connections.

Poor cable connections Check the Ethernet cabling for the following:
• Make sure that cables are fully connected.
• Check for cable crimping.
• Check the Ethernet switch connections.
• Check the Uplink ports.

Invalid IP address of terminal Go to Set the Ethernet Address of the Terminal on page 55.
If DHCP is enabled, the terminal automatically acquires a valid IP 
address from the network after startup. The TCP/IP protocol 
automatically assigns 169.254.xxx.xxx when it fails to acquire an 
IP address from the network. In general, an IP address that begins 
with 169 does not support a network connection.

Conflicting IP addresses If DHCP is not enabled and a static IP address is specified, make 
sure that the IP address does not conflict with the address of 
another device on the network.

TIP For more information on chemical resistance of the product, go to 
http://www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘Chemical Resistance PanelView™ Plus’.

IMPORTANT Do not operate the terminal in direct sunlight. Direct exposure to 
ultraviolet light can discolor the touch screen.
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Clean the Display A protective overlay can help extend the life of the terminal and make it easier 
to clean the display. Table 4 on page 17 provides catalog numbers for overlays.
 

To clean the display, follow these steps.

1. Disconnect power from the terminal at the power source.

2. To clean the display and to prevent scratches, use a clean sponge or soft 
cloth with mild soap or detergent.

3. Dry the display with a chamois or moist cellulose sponge to avoid water 
spots.

Remove Paint and Grease

Follow these steps to remove paint or grease from the bezel that is properly 
mounted in a NEMA, UL Type, or IP rated enclosure.

1. Rub lightly with isopropyl alcohol (70% concentration).

2. To remove residue, use a mild soap or detergent solution.

3. Rinse with clean water.

Equipment Wash Downs

ATTENTION: Do not use abrasive cleaners or solvents, they can damage the 
display. Do not scrub or use brushes.
Do not apply cleaning solution directly on the screen of the terminal. The 
solution can drip or seep onto the gasket. Apply cleaning solution to a clean 
sponge or soft cloth, and gently wipe the screen to remove the dirt and grime.

ATTENTION: Do not use a high-pressure washer for cleaning the front bezel 
of the terminal. A high-pressure washer can damage the terminal.
Do not use a high-pressure washer for cleaning vented enclosures. Water can 
enter the enclosure and damage the terminal and other equipment.
It is possible for screen objects to activate during equipment wash-downs if the 
terminal is turned on.
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Ship the Terminal If you ship the enclosure with the terminal installed, make sure that the 
terminal is properly secured and protected against damage from impact, sharp 
objects, or abrasive materials.

Maintenance Mode 
Operations

To start the system in Maintenance Mode for diagnostics and repairs, press and 
hold the white box that shows in the lower left corner of the display during 
startup.

If an ME application is set to run at terminal startup, press and hold the white 
box during startup to put the terminal into Safe Mode.

Perform maintenance operation in this order to diagnose and repair problems:
• Safe mode – stops an application from starting automatically.
• Clear all data – removes user-installed applications, user-configuration 

changes, and user accessible data.
• Factory default – returns the terminal to its out-of-box state.

ATTENTION: Rockwell Automation is not responsible for damage to a 
product that is shipped or transported while installed in a panel or 
enclosure.

TIP To access the Maintenance Mode menu, you can also attach a USB 
keyboard and hold down the F1 key.

Table 39 - Maintenance Mode Operations

Operation Description 

None Exits Maintenance mode and continues with a normal restart.

Safe mode

Starts the system in Safe Operating mode. Safe mode is a diagnostic mode with reduced functionality that lets you recovery from a software 
anomaly. In Safe mode, you can repair corrupted applications or changes that caused the anomaly.
Important: FactoryTalk View ME Station software does not run the HMI .mer application on startup if one is loaded, but instead enters Configuration 
mode. The HMI application runs the next time that the system is reset.

Clear all data Restores all user-accessible storage and configuration data on the terminal to its default state. The current firmware revision is retained.
Important: All storage media is returned to its original state when purchased except for the firmware. The latest FactoryTalk View ME image is 
retained. All user data changes or additions are lost.

Factory default Restores all storage media on the terminal to its initial factory default state, including firmware, registry, file system, and configuration data. 
Typically, this option is used to recover from a failed firmware update.
Important: All storage media is returned to its original state when purchased. All user-installed, firmware updates are removed.
Refer to Restore a Back-up Image on page 86 for details on how to perform a restore.
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Notes:
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Fonts Resident on Terminal

TrueType Fonts The table lists TrueType fonts that are pre-installed on the terminals. The 
default system font is Tahoma. 

You can load more fonts on the system by copying the font files to the 
\Windows\Fonts folder on the terminal desktop. To access this folder, open 
the My Device icon on the terminal desktop or choose 
Start>Programs>Windows Explorer.

TIP The Arial Unicode MS font contains almost 50,000 characters. The font 
provides default language support for many non-Latin languages and 
scripts including Arabic, Hebrew, Vietnamese, Thai, Hindi (Devanagari), 
and other Indic languages. The font also includes Chinese, Japanese, and 
Korean (CJK) support.

IMPORTANT OpenType fonts (.otf) can contain many extra symbols and characters and 
can have large files sizes. If you install OpenType fonts, it can result in a 
reduction in available memory for applications. We recommend that you 
install only TryeType fonts. If you need an OpenType font, install only the 
font family that you want to use.

Table 40 - TrueType Fonts (.ttf and .ttc)

Font Type Font Name File Name

Latin Fonts

Arial Unicode MS version 1.01 arialuni.ttf

Arial

Arial (Subset 1_30) arial_1_30.ttf

Arial Black arialk.ttf

Arial Bold arialbd.ttf

Arial Bold Italic arialbi.ttf

Arial Italic ariali.ttf

Comic Sans MS

Comic Sans MS comic.ttf

Comic Sans MS Bold comicbd.ttf

Courier New

Courier New (Subset 1_30) cour_1_30.ttf

Courier New Bold courbd.ttf

Courier New Bold Italic courbi.ttf

Courier New Italic couri.ttf
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Latin Fonts

Georgia

Georgia georgia.ttf

Georgia Bold georgiab.ttf

Georgia Bold Italic georgiaz.ttf

Georgia Italic georgiai.ttf

Impact impact.ttf

Kino kino.ttf

Microsoft Logo mslogo.ttf

Symbol symbol.ttf

Tahoma

Tahoma (Subset 1_07) tahoma_1_07.ttf

Tahoma Bold tahomabd.ttf

Times New Roman

Times New Roman  (Subset 1_30) times_1_30.ttf

Times New Roman Bold timesbd.ttf

Times New Roman Bold Italic timesbi.ttf

Times New Roman Italic timesi.ttf

Trebuchet MS

Trebuchet MS trebuc.ttf

Trebuchet MS Bold trebucbd.ttf

Trebuchet MS Bold Italic trebucbi.ttf

Trebuchet MS Italic trebucit.ttf

Verdana

Verdana verdana.ttf

Verdana Bold verdanab.ttf

Verdana Bold Italic verdanaz.ttf

Verdana Italic verdanai.ttf

Symbols
Webdings webdings.ttf

Wingding wingding.ttf

Table 40 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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PanelView Fonts

PV 12 x 24, PV 12 x 8 PV12x24.tff, PV12x8.ttf

PV 16 x 24 PV16x24.ttf

PV 18 x 16, PV 18 x 8 PV18x16.ttf, PV18x8.ttf

PV 24 x 32 PV24x32.ttf

PV 32 x 40, PV 32 x 64 PV32x40.ttf, PV32x64.ttf

PV 4 x 6 PV4x6.ttf

PV 6 x 16, PV 6 x 24, PV 6 x 8, PV 6 x 9 PV6x16.ttf, PV6x24.ttf, 
PV6x8.ttf, PV6x9.ttf

PV 8 x 16, PV 8 x 20, PV 8 x 24 PV8x16.ttf, PV8x20.ttf, 
PV8x24.ttf

PV Double High PVdouble_high.ttf

PV Double Wide PVdouble_wide.ttf

PV Extra Large PVextra_large.ttf

PV Large PVlarge.ttf

PV Small PVsmall.ttf

PV Tiny PVtiny.ttf

PV Very Tiny PVvery_tiny.ttf

East Asian Fonts
Gulim version 2.21 - Korean gulim.ttc

MS Gothic version 2.30 - Japanese gulim.ttc

Table 40 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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Notes:
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Index

Symbols
.mer application 41, 45, 53, 59, 68

A
access configuration mode

from an HMI application 41
from the Windows desktop 41
Goto configuration mode button 41

accessories 17
ActiveX controls 14, 72
alarms 69
application

back up 84
checking integrity 68
restore 84

ATEX
installations 13

atmospheric gases ignition temperature 23
authenticating client connections 94

B
back-up image 86
back-up power 123
battery

back-up power 123
conditions 91
lithium 123
replacement 123
view voltage 91
warnings 110

battery voltage 70
boot options 111
branch circuit 20
button styles 111

C
cable

capacitance values 25
inductance values 25
lengths between Ethernet ports 37

calibration
touch screen 63, 113

catalog numbers
battery replacement 18
mounting hardware 17
PanelView Plus 7 standard terminals 16
power supplies 17
power terminal blocks 17
protective overlays 17
SD cards 17
USB programming cable 17

circuit breaker rating 20
clear all data 143
closed system 111

command prompt
Foxitreader 115
parameters 115
syntax 115

configuration mode 15
configure start-up options 41
control panel

touch screen calibration 113
cutout dimensions 26

D
date

setting 74
date format

long 77
short 77

DC power bus 35
desktop

appearance 88
background image 88
brightness 88
cursor 89
rotate 89
screen saver 89

desktop access
default password 46
disable 47
enable 46
password 46
reset password 50
restrict 46, 47
set password 49

device name
terminal 58

DHCP 55
diagnostics 67

advanced 112
dimensions

panel cutout 26
display

adjust backlight 61
download publications 9

E
earth ground

connection 36
wire 35

electrostatic discharge 117
environment and enclosure notice 20
error indicator 138
ESD

preventing 117
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Ethernet
connector pinout 37
driver 54
duplex setting 56
link speed 56
status indicators 37

event log
errors 69
events 69
warnings 69

explosion hazard 34, 37, 123

F
FactoryTalk View ME

check file integrity 68
diagnostics 68

fault indicators
firmware 138
hardware 138

file server
configuration 108

firmware
copy upgrade files

to a USB flash drive 129
to an SD card 129

corrupted 132
downloading 128
revision 72
upgrade fails 132, 136
upgrade methods 129
upgrade package 128
upgrade wizard 129

firmware upgrade
using storage device 129
via network connection 133
via SD card 132
via USB flash drive 132
wizard 129

fonts 145
Foxitreader 115
FTP security options 106
FTP server

configuration 105
parameters 105

ftp server
security 105

FUP 128
fuse rating 20
FUW 128

G
galvanic isolation 118

H
hardware specifications

battery 13
display/touch screen 12
Ethernet port 12
SD card slot 13
status indicators 13
USB device port 12
USB host port 12

HMI 9

I
indicator

ERR 138
STS 138

INMETRO
installations 13

input panels 82
installation

panel cutouts 26
IP address

assign 55

K
KEPServer drivers 130, 135
keyboard 82

L
ladder logic 9
language

setting 75
lithium batteries

safe handling 123
log files

application files 68
delete 60
runtime files 68

M
maintenance mode 143
ME 9
mount the terminal

ambient temperature 25
clearances 25
in a panel 30
location considerations 25
minimum clearances 25
mounting levers 27
preparation 27

N
NEC 24
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Index

network
file servers 108
FTP servers 105
topology 36
types supported 36
VNC servers 97

network topology
device level ring (DLR) 37
linear 38
star 39

numeric keypad 13

P
panel cutout dimensions 26
PDF reader 114
power

24V DC nominal 35
connection 35
DC bus 35
ratings 35
specification 12
supplies 35
terminal block

install 34
remove 34
wire specifications 34

power supply
PELV 35
SELV 35

print setup 65
printers 119
processes

memory usage 90
running on the terminal 90

product compatibility and download center 
10

protective overlay 125
cleaning 126
installing 125
removing 126

publications
download 9

R
release notes 10
reset terminal 41
restore application 84
RJ45 connector 37
RSLinx Enterprise software 54

S
safe mode 111, 143

safety notices
battery replacement 123
earth ground connection 36
electrical arc 34, 37, 121
electrical shock 117
emergency stops 19
explosion hazard 34, 37
grounding USB devices 118
wiring and safety guidelines 20

screen cursor
enable/disable 62

screen saver
configure 62

SD card
ATEX 13
INMETRO 13
installing 122
slot 122

server
addresses 57
enable/disable 96
file 108
ftp 105

set up printers 65
shell options 110
soft keyboard controls 44
software versions

FactoryTalk View Machine Edition Station 14
FactoryTalk View Studio for Machine Edition 

14
FactoryTalk ViewPoint 14

startup
configure 41
options 15, 40, 51
sequence 40

status indicators 138
Ethernet 37

STS indicator 138
system

information 137
status 138

system event log 90
maximum size 90

T
technical support 72
temperature

code T4 23
conditions 91
failed sensor 91
view current temperature 91

terminal
device name 58
settings 43

terminal block
power 34

terminal configuration
closed system 14
open system 14
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terminal status
battery voltage 70
memory allocation 71
runtime RAM 71

time
format 76
setting 74
zone 73

touch screen
calibrate 63, 113
gestures

double-tap 13
drag 13
long press 13
tap 13

input 13
set sensitivity 64

touch screen calibration 113
troubleshooting 90

U
USB

cables 119
device port 118
host port 24, 118
host port circuit parameters 24
hubs 119
printer 119

USB to serial port adapters 18
user accounts 94

V
virtual keyboard 13
VNC 14

configure 97
connection passwords 97
control passwords 98
server parameters 97
view-only password 98

W
watchdog errors 112
Web server parameters 104
Windows CE

operating system 14
features 79

server support 81
Windows control panel 83
Windows Explorer 82
wiring and safety guidelines 20
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